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Preface

Audience for This Guide
Welcome to Release 11i of the Oracle Applications Interaction Center 
Implementation Guide.

This guide assumes you have a working knowledge of the following:

� The principles and customary practices of your business area.

� Oracle Interaction Center

If you have never used Oracle Interaction Center, Oracle suggests you attend 
one or more of the Interaction Center training classes available through Oracle 
University.

� The Oracle Applications graphical user interface. 

To learn more about the Oracle Applications graphical user interface, read the 
Oracle Applications User’s Guide.

See Other Information Sources for more information about Oracle Applications 
product information.

How To Use This Guide
This document contains the information you need to understand and use Oracle 
Interaction Center.

Chapter 1, "Introduction", describes the components of the Interaction Center 
product family and the key features of Oracle Interaction Center. This chapter also 
lists any new or obsolete features in this release.
xi



Chapter 2, "Technology, Requirements, and Performance", describes the technology 
stack for Oracle Interaction Center and the Oracle Interaction Center architecture. 
This chapter also lists the minimum hardware and software configuration for 
Oracle Interaction Center.

Chapter 3, "Dependency Requirements and Verification", describes applications that 
are required for Oracle Interaction Center to function or that provide addtional 
functionality.

Chapter 4, "Implementation Overview", describes the implementation process and 
lists the implementation steps.

Chapter 5, "Implementation Tasks", provides task-based procedures for 
implementing Oracle Interaction Center.

Chapter 6, "Verifying the Implementation", provides task-based procedures for 
verifying that the impementation of Oracle Interaction Center is successful.

Chapter 7, "Diagnostics and Troubleshooting", describes how to troubleshoot the 
implementation of Oracle Interaction Center.

Appendix A, "Oracle Interaction Center Implementation Worksheets", provides 
worksheets for recording implementation decisions.

Appendix B, "Oracle Interaction Center Server Parameters", lists database server 
parameters for Oracle Interaction Center.

Appendix C, "Oracle Interaction Center Command Line Parameters", lists command  
line server parameters for Oracle Interaction Center

Documentation Accessibility 
Our goal is to make Oracle products, services, and supporting documentation 
accessible, with good usability, to the disabled community. To that end, our 
documentation includes features that make information available to users of 
assistive technology. This documentation is available in HTML format, and contains 
markup to facilitate access by the disabled community. Standards will continue to 
evolve over time, and Oracle Corporation is actively engaged with other 
market-leading technology vendors to address technical obstacles so that our 
documentation can be accessible to all of our customers. For additional information, 
visit the Oracle Accessibility Program Web site at 
http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation JAWS, a Windows screen 
reader, may not always correctly read the code examples in this document. The 
xii



conventions for writing code require that closing braces should appear on an 
otherwise empty line; however, JAWS may not always read a line of text that 
consists solely of a bracket or brace.

Other Information Sources
You can choose from many sources of information, including online 
documentation, training, and support services, to increase your knowledge and 
understanding of Oracle Interaction Center.

If this guide refers you to other Oracle Applications documentation, use only the 
Release 11i versions of those guides.

Online Documentation
All Oracle Applications documentation is available online (HTML or PDF). Online 
help patches are available on MetaLink.

Related Documentation
Oracle Interaction Center shares business and setup information with other Oracle 
Applications products. Therefore, you may want to refer to other product 
documentation when you set up and use Oracle Interaction Center.

You can read the documents online by choosing Library from the expandable menu 
on your HTML help window, by reading from the Oracle Applications Document 
Library CD included in your media pack, or by using a Web browser with a URL 
that your system administrator provides.

If you require printed guides, you can purchase them from the Oracle Store at 
http://oraclestore.oracle.com.

Documents Related to All Products

Oracle Applications User’s Guide
This guide explains how to enter data, query, run reports, and navigate using the 
graphical user interface (GUI) available with this release of Oracle Interaction 
Center (and any other Oracle Applications products). This guide also includes 
information on setting user profiles, as well as running and reviewing reports and 
concurrent processes.

You can access this user’s guide online by choosing”Getting Started with Oracle 
Applications” from any Oracle Applications help file.
xiii



Documents Related to This Product

Oracle Universal Work Queue Concepts and Procedures
Use this guide to administer and user Oracle Universal Work Queue.

Oracle Applications Interaction Center Implementation Guide
Use this guide to implement Interaction Center Server Manager.

Oracle Advanced Inbound Implementation Guide
Use this guide to implement inbound media for an interaction center.

Oracle Advanced Outbound Implementation Guide
Use this guide to implement outbound media for an interaction center.

Oracle Scripting Implementation Guide
Use this guide to implement Oracle Scripting.

Oracle eMail Center Implementation Guide
Use this guide to implement Oracle eMail Center.

Oracle Interaction Center Intelligence Implementation Guide
Use this guide to implement Oracle Interaction Center Intelligence.

Installation and System Administration

Oracle Applications Concepts
This guide provides an introduction to the concepts, features, technology stack, 
architecture, and terminology for Oracle Applications Release 11i. It provides a 
useful first book to read before an installation of Oracle Applications. This guide 
also introduces the concepts behind Applications-wide features such as Business 
Intelligence (BIS), languages and character sets, and Self-Service Web Applications.

Installing Oracle Applications
This guide provides instructions for managing the installation of Oracle 
Applications products. In Release 11i, much of the installation process is handled 
using Oracle Rapid Install, which minimizes the time to install Oracle Applications, 
the Oracle8 technology stack, and the Oracle8i Server technology stack by 
automating many of the required steps. This guide contains instructions for using 
xiv



Oracle Rapid Install and lists the tasks you need to perform to finish your 
installation. You should use this guide in conjunction with individual product 
user’s guides and implementation guides.

Oracle Applications Supplemental CRM Installation Steps
This guide contains specific steps needed to complete installation of a few of the 
CRM products. The steps should be done immediately following the tasks given in 
the Installing Oracle Applications guide.

Upgrading Oracle Applications
Refer to this guide if you are upgrading your Oracle Applications Release 10.7 or 
Release 11.0 products to Release 11i. This guide describes the upgrade process and 
lists database and product-specific upgrade tasks. You must be either at Release 10.7 
(NCA, SmartClient, or character mode) or Release 11.0, to upgrade to Release 11i. 
You cannot upgrade to Release 11i directly from releases prior to 10.7.

Maintaining Oracle Applications
Use this guide to help you run the various AD utilities, such as AutoUpgrade, 
AutoPatch, AD Administration, AD Controller, AD Relink, License Manager, and 
others. It contains how-to steps, screenshots, and other information that you need to 
run the AD utilities. This guide also provides information on maintaining the 
Oracle applications file system and database.

Oracle Applications System Administrator’s Guide
This guide provides planning and reference information for the Oracle Applications 
System Administrator. It contains information on how to define security, customize 
menus and online help, and manage concurrent processing.

Oracle Alert User’s Guide
This guide explains how to define periodic and event alerts to monitor the status of 
your Oracle Applications data.

Oracle Applications Developer’s Guide
This guide contains the coding standards followed by the Oracle Applications 
development staff. It describes the Oracle Application Object Library components 
needed to implement the Oracle Applications user interface described in the Oracle 
Applications User Interface Standards for Forms-Based Products. It also provides 
information to help you build your custom Oracle Forms Developer 6i forms so that 
they integrate with Oracle Applications.
xv



Oracle Applications User Interface Standards for Forms-Based Products
This guide contains the user interface (UI) standards followed by the Oracle 
Applications development staff. It describes the UI for the Oracle Applications 
products and how to apply this UI to the design of an application built by using 
Oracle Forms.

Other Implementation Documentation

Oracle eTechnical Reference Manuals
Each eTechnical Reference Manual (eTRM) contains database diagrams and a 
detailed description of database tables, forms, reports, and programs for a specific 
Oracle Applications product. This information helps you convert data from your 
existing applications, integrate Oracle Applications data with non-Oracle 
applications, and write custom reports for Oracle Applications products. Oracle 
eTRM is available on Metalink

Oracle CRM Application Foundation Implementation Guide
Many CRM products use components from CRM Application Foundation. Use this 
guide to correctly implement CRM Application Foundation.

Training and Support

Training
Oracle offers training courses to help you and your staff master Oracle Interaction 
Center and reach full productivity quickly. You have a choice of educational 
environments. You can attend courses offered by Oracle University at any one of 
our many Education Centers, you can arrange for our trainers to teach at your 
facility, or you can use Oracle Learning Network (OLN), Oracle University’s online 
education utility. In addition, Oracle training professionals can tailor standard 
courses or develop custom courses to meet your needs. For example, you may want 
to use your organization’s structure, terminology, and data as examples in a 
customized training session delivered at your own facility.

Support
From on-site support to central support, our team of experienced professionals 
provides the help and information you need to keep Oracle Interaction Center 
working for you. This team includes your Technical Representative, Account 
Manager, and Oracle’s large staff of consultants and support specialists with 
xvi



expertise in your business area, managing an Oracle8i server, and your hardware 
and software environment.

OracleMetaLink
OracleMetaLink is your self-service support connection with web, telephone menu, 
and e-mail alternatives. Oracle supplies these technologies for your convenience, 
available 24 hours a day, 7 days a week. With OracleMetaLink, you can obtain 
information and advice from technical libraries and forums, download patches, 
download the latest documentation, look at bug details, and create or update TARs. 
To use MetaLink, register at (http://metalink.oracle.com).

Alerts: You should check OracleMetaLink alerts before you begin to install or 
upgrade any of your Oracle Applications. Navigate to the Alerts page as follows: 
Technical Libraries/ERP Applications/Applications Installation and 
Upgrade/Alerts.

Self-Service Toolkit: You may also find information by navigating to the 
Self-Service Toolkit page as follows: Technical Libraries/ERP 
Applications/Applications Installation and Upgrade.

Do Not Use Database Tools to Modify Oracle Applications Data
Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data 
Browser, database triggers, or any other tool to modify Oracle Applications data 
unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and 
maintain information in an Oracle database. But if you use Oracle tools such as 
SQL*Plus to modify Oracle Applications data, you risk destroying the integrity of 
your data and you lose the ability to audit changes to your data.

Because Oracle Applications tables are interrelated, any change you make using 
Oracle Applications can update many tables at once. But when you modify Oracle 
Applications data using anything other than Oracle Applications, you may change a 
row in one table without making corresponding changes in related tables. If your 
tables get out of synchronization with each other, you risk retrieving erroneous 
information and you risk unpredictable results throughout Oracle Applications.

When you use Oracle Applications to modify your data, Oracle Applications 
automatically checks that your changes are valid. Oracle Applications also keeps 
track of who changes information. If you enter information into database tables 
using database tools, you may store invalid information. You also lose the ability to 
xvii



track who has changed your information because SQL*Plus and other database 
tools do not keep a record of changes.

About Oracle
Oracle Corporation develops and markets an integrated line of software products 
for database management, applications development, decision support, and office 
automation, as well as Oracle Applications, an integrated suite of more than 160 
software modules for financial management, supply chain management, 
manufacturing, project systems, human resources and customer relationship 
management.

Oracle products are available for mainframes, minicomputers, personal computers, 
network computers and personal digital assistants, allowing organizations to 
integrate different computers, different operating systems, different networks, and 
even different database management systems, into a single, unified computing and 
information resource.

Oracle is the world’s leading supplier of software for information management, and 
the world’s second largest software company. Oracle offers its database, tools, and 
applications products, along with related consulting, education, and support 
services, in over 145 countries around the world.
xviii



Introd
1

Introduction

Topics include:

� Section 1.1, "Oracle Interaction Center Overview"

� Section 1.2, "Interaction Center Server Manager Overview"

� Section 1.3, "New in this Release"

� Section 1.4, "Obsolete in this Release"

1.1 Oracle Interaction Center Overview
Every customer interaction -- a telephone call, an email, or a Web chat -- presents an 
opportunity to win new business or improve customer satisfaction. An interaction 
center is an environment in which human agents manage interactions with 
customers through multiple contact channels. 

Oracle Interaction Center is one of several applications in the Oracle Interaction 
Center. The Oracle Interaction Center is a suite of applications that supports the 
management and processing of customer relationship activity across all channels of 
customer contact.

The Oracle Interaction Center suite includes:

Oracle Advanced Inbound Oracle Advanced Inbound enables Oracle Customer 
Relationship Management (CRM) business applications to handle multiple media 
channels.

Oracle Advanced Outbound Oracle Advanced Outbound provides list 
management and predictive dialing for outbound telephony campaigns.
uction 1-1



Interaction Center Server Manager Overview
Oracle eMail Center Oracle eMail Center is an email interaction management 
application. Oracle eMail Center can automate or suggest responses to inbound 
email.

Oracle Scripting Oracle Scripting is an application for developing and deploying 
scripted presentations for customer interactions. The scripted presentations guide 
agents through their interactions with customers.

See Also
� Section 1.2, "Interaction Center Server Manager Overview"

� Section 1.3, "New in this Release"

� Section 1.4, "Obsolete in this Release"

1.2 Interaction Center Server Manager Overview
Interaction Center Server Manager is a new Java server process that starts, stops, 
and monitors interaction center server processes. It is required to run any 
interaction center servers.

See Also
� Section 1.1, "Oracle Interaction Center Overview"

� Section 1.3, "New in this Release"

� Section 1.4, "Obsolete in this Release"

1.2.1 Oracle Interaction Center Features
Interaction Center Server Manager features include:

� Server process control including startup and shutdown

� Server process status monitoring including status, logs files, and trace files

� Scalability using multiple nodes

1.3 New in this Release
Topics include:

� Section 1.3.1, "Interaction Center Server Manager"
1-2 Oracle Applications Interaction Center Implementation Guide



New in this Release
� Section 1.3.2, "Interaction Queuing and Distribution Server"

� Section 1.3.3, "Multi-Site Interaction Centers"

� Section 1.3.4, "HTML Server Group Administration"

� Section 1.3.5, "HTML Call Center Administration"

See Also
� Section 1.1, "Oracle Interaction Center Overview"

� Section 1.2, "Interaction Center Server Manager Overview"

� Section 1.4, "Obsolete in this Release"

1.3.1 Interaction Center Server Manager
Interaction Center Server Manager is responsible for starting, stopping and 
monitoring interaction center server processes. Only Interaction Center Server 
Manager is installed on the target machine. All batch and script files from previous 
releases can be discarded.

1.3.2  Interaction Queuing and Distribution Server
Interaction Queuing and Distribution server stores all inbound items and their 
routing information in queues and distributes them to agents. It integrates with 
Routing and Interaction Blending. Interaction Queueing and Distribution server is 
required in all Advanced Inbound and Advanced Outbound implementations.

A typical single site installation of Advanced Inbound consists of: 

      - one Oracle Call Center Connectors 

      - one Oracle Inbound Telephony Server 

      - one Oracle Interaction Queue and Distribution server 

      - one or more Oracle Telephony Manager server

      - one or more Oracle Universal Work Queue server

      - one or more Oracle Routing server
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Obsolete in this Release
1.3.3 Multi-Site Interaction Centers 
A multi-site interaction center includes a global server group and multiple local 
server groups. The global server group controls queueing, distribution, and routing 
for the local server groups. 

Call routing and call-and-data transfer for multi-site interaction centers is currently 
supported for Avaya Definity and Nortel Meridian with Intel CT-Connect 
Enterprise Edition v5.0 + Service Pack 3 only. 

A global site in a multi-site interaction center typically consists of: 

� one Interaction Queue and Distribution server 

� one Routing server

A local site in a multi-site interaction center typically consists of: 

� one Inbound Telephony Server 

� one or more Telephony Manager servers

� one or more Universal Work Queue servers

1.3.4 HTML Server Group Administration
Server groups and server processes are now administered using an HTML interface. 
Use the Call Center HTML Administration or Interaction Center Server Manager 
responsibility.

1.3.5 HTML Call Center Administration
Call center administration activities, including routing and call classification, are 
now administered using an HTML interface. Use the Call Center HTML 
Administration responsibility.

1.4 Obsolete in this Release
Topics include:

� Section 1.4.1, "Call Center Administration (Forms)"

� Section 1.4.2, "Server Locator Administration (Forms)"

� Section 1.4.3, "Call Center Applications Setup CD"

� Section 1.4.4, "Standalone/Distributed Mode"
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Obsolete in this Release
� Section 1.4.5, "Server Monitor and Server Launcher"

� Section 1.4.6, "Telephony Media Controller Server"

See Also
� Section 1.1, "Oracle Interaction Center Overview"

� Section 1.2, "Interaction Center Server Manager Overview"

� Section 1.3, "New in this Release"

1.4.1 Call Center Administration (Forms)
Call Center administration, including routing and call classification, using Oracle 
Forms is no longer supported. These interaction center activities are now 
administered using an HTML interface. Use the Call Center HTML Administration 
responsibility.

1.4.2 Server Locator Administration (Forms)
Interaction center server group administration using Oracle Forms is no longer 
supported. Server groups and server processes are now administered using an 
HTML interface. Use the Call Center HTML Administration or Interaction Center 
Server Manager responsibility.

1.4.3 Call Center Applications Setup CD
The Call Center Applications Setup CD is obsolete. The Call Center Applications 
Setup D can be discarded.

You may safely delete all batch files and shell scripts installed by the Call Center 
Applications Setup CD.

1.4.4 Standalone/Distributed Mode
Standalone and distributed modes are no longer relevant. The concepts are now 
changed and will be called single -site and multi-site installations. 

1.4.5 Server Monitor and Server Launcher
Server Monitor and Server Launcher are now obsolete. They have been replaced by 
Interaction Center Server Manager. 
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1.4.6 Telephony Media Controller Server
Telephony Media Controller server is now obsolete.The functionality in Telephony 
Media Controller server is now in Telephony Manager server.
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Technology, Requirements, and

Performance

Topics include:

� Section 2.1, "Architectural Overview"

2.1 Architectural Overview
Interaction Center Server Manager is a set of shell scripts and batch files that start, 
stop, and monitor the server processes in an interaction center server group. 
Interaction Center Server Manager is installed on any target machine and is 
controlled at the command line. The server processes assigned to a target machine 
are controlled by an HTML administration interface in Oracle Applications.

Topics include:

� Section 2.1.1, "Single-Site Interaction Center"

� Section 2.1.2, "Multi-Site Interaction Centers"

2.1.1 Single-Site Interaction Center
The servers are logically grouped together in a server group. The servers 
communicate with server in the same server group only. Some of the servers can be 
replicated or distributed across multiple machines to support better scalability. For 
example, the computer-telephony integration work load can be shared among 
several Telephony Manager servers. 

A typical single site server configuration consists of:

� one PBX and middleware 
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Minimum Software Requirements
� one Call Center Connectors server

� one Inbound Telephony server 

� one Interaction Queuing and Distribution server

� one or more Routing servers 

� one or more Telephony Manager servers 

� one or more Universal Work Queue server 

The configuration is the same whether routing is controlled by the switch (passive) 
or the Routing server (active).

2.1.2 Multi-Site Interaction Centers
A multi-site server configuration include a global server group and several local 
server groups. The local server groups are associated with the global server group.

A global server group is configured with the following servers:

� one Interaction Queuing and Distribution Server 

� one or more Routing Server 

Each local server group consists of:

� one PBX and middleware 

� one Call Center Connector server

� one Inbound Telephony server 

� one or more Telephony Manager servers 

� one or more Universal Work Queue servers 

The configuration is the same whether routing is controlled by the switch (passive) 
or the Routing server (active).

2.2 Minimum Software Requirements
Topics include:

� Section 2.2.1, "Oracle Applications, Release 11i"

� Section 2.2.2, "Java Development Kit (JDK) or Java Runtime Environment (JRE)"

� Section 2.2.3, "Database Connectivity File"
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Minimum Software Requirements
2.2.1 Oracle Applications, Release 11i
Install or upgrade Oracle Applications, Release 11i. Interaction Center Server 
Manager files are downloaded from Oracle Applications. 

The Oracle Applications Rapid Install installs a complete set of Oracle Applications 
products at the latest available maintenance pack level. It installs the required 
technology stack components, creates the Oracle Applications database, and installs 
the Oracle Applications file system components. For more information, see 
Installing Oracle Applications, Release 11i.

Ensure that the target machine can access the most recent Oracle Applications 
apps.zip and jdbc111.zip files. The Oracle Applications apps.zip file contains the 
functionality for the interaction center servers. The Oracle Applications jdbc111.zip 
file contains Java database connectivity information. These files are typically found 
in the JAVA_TOP directory that was created during the installation of Oracle 
Applications.

You have the following options:

� Create a network file system link to the apps.zip and jdbc111.zip files on the 
Oracle Applications server to which patches are most often applied, such as the 
Administration Server. The format of the path to the files will depend on how 
the network file system is set up. For information specific to your enterprise, 
please contact your system administrator.

This configuration makes patches to the Oracle Applications apps.zip or 
jdbc111.zip files immediately available to the target machine. However, system 
processing is slower.

� Copy the Oracle Applications apps.zip and jdbc111.zip files from an Oracle 
Applications server to the target machine (either manually or by performing a 
web tier installation of Oracle Applications).

This configuration is faster. However, patches to the Oracle Applications 
apps.zip or jdbc111.zip files on the Oracle Applications servers are not 
immediately available to the target machine.

2.2.2 Java Development Kit (JDK) or Java Runtime Environment (JRE)
The Java Development Kit (JDK) or Java Runtime Environment (JRE) provide the 
Java virtual machine in which Interaction Center Server Manager runs. Interaction 
Center Server Manager and a Java Runtime Environment (JRE) are installed during 
a rapid installation of the Oracle Applications web server. 
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If you intend to use additional target machines, ensure that JDK or JRE is installed 
on the target machine. You can use the following JDK/JRE versions to run 
Interaction Center Server Manager:

� 1.3.1

� 1.3.0

� 1.2.2

� 1.1.8

You have the following options:

� Perform a web tier installation of Oracle Applications on the target machine.

� Obtain and install JDK or JRE manually on the target machine.

You can download JDK/JRE from Sun or the hardware vendor. You should 
perform all necessary operating system tuning for the specific platform. For 
example,  on HP it is required that the operating system kernel parameter max_
proc_thread be raised from the default value of 64 to at least 1024. Please 
contact your hardware vendor for additional information.

2.2.3 Database Connectivity File
Create a database connectivity file (for example, *.dbc) on the target machine. The 
database connectivity file is a text file that contains the connection parameters for 
the Oracle Applications database.

The following table lists the necessary connection parameters for the database 
connectivity file. If you do not know the appropriate values, then contact your 
Oracle Applications system administrator or database administrator.

Note: If you run Interaction Center Server Manager using 
JDK.JRE 1.1.8, please edit the ieoenv file. Put the jdbc111.zip before 
jdbc12.zip in the classpath. This is required for correct functioning 
or interaction center server processes.

Parameter Description

TWO_TASK The name of the database or the SID.

FNDNAM The default value is ’apps.’ Do not change this value.
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The following is an example of a DBC file:

#DB Settings
#10OCT2001
TWO_TASK=dbsid
FNDNAM=apps
GWYUID=applsyspub/pub
GUEST_USER_PWD=userid/password
APPS_JDBC_DRIVER_TYPE=THIN
DB_HOST=machinename.us.oracle.com
DB_PORT=1527

2.3 Minimum Hardware Requirements
Topics include:

� Section 2.3.1, "Static IP Address"

2.3.1 Static IP Address
The target machine must have a static IP address to run ICSM. Use the following 
procedure to identify the IP address of the target machine. 

1. Choose Start > Settings > Control Panel.

2. Double-click Network.

3. In the Protocols tab, click TCP/IP Protocol and then click Properties.

4. Under Specify an IP address, note the IP Address.

GWYUID The gateway userid and password.

FND_MAX_JDBC_CONNECTIONS The default value is ’20.’ Do not change this value.

GUEST_USER_PWD An Oracle Applications database guest userid and password.

APPS_JDBC_DRIVER_TYPE The default value is ’THIN.’ Do not change this value.

DB_HOST The name of the host machine for the Oracle Applications database.

DB_PORT The listener port number for the Oracle Applications database. The 
Oracle database client on the target machine communicates with the 
Oracle Applications database using this port number.

Parameter Description
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If an IP address is not configured, please contact your network administrator.

2.4 Scalability and Performance Guidelines
This document describes the memory requirement of Interaction Center Server 
processes.

2.4.1 Introduction
Interaction Center Server processes are Java processes that can be configured to run 
with certain amount of allocated memory. Each server process has its required 
memory allocation to be functional. The memory allocation for a Java process is 
specified by the Java command line -ms and -mx options, which define the 
minimum and maximun amount of memory allocated. 

ICSM stores this information in the database as seed data for each server type such 
that each server would have the default amount of memory allocated when the 
server is run.

2.4.2 Default Memory Settings
The following table defines the default memory allocated for each server type. The 
minimum memory required is the memory that the Java Virtual Machine will 
allocate upfront when the process is started. The maximum memory required is the 
upper bound of the memory allocation that the Java Virtual Machine can grow.

Server Type

Default Memory Settings

(Minimum / Maximum) Default Java Option

Unvisersal Work Queue 
Server

64M / 128M -ms64m -mx128m

Interaction Queuing and 
Distribution Server

128M / 256M- ms128M -mx256M

Interaction Blending 
Server

16M / 32M -ms16M -mx32M

Routing Server 16M / 32M -ms16M -mx32M

Oracle Telephony 
Manager

128M / 256M -ms128M -mx256M
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2.4.3 Minimum Memory Requirement Calculation
You should always use the maximum value to calculate the amount of physical 
memory needed for the machine running interaction  center servers. 

For example, a typical call center running Advanced Inbound will have 1 OTM , 1 
UWQ , 1 ITS , 1 IQD , 1 Routing server; thus, the memory required to run all the 
servers will be : 256 + 128 + 32 + 256 + 32 = 704 MB. Therefore, without tuning the 
memory allocations, a machine with at least 768MB physical memory must be used 
to run all of the above server processes without having  unpredictable 
OutOfMemory errors.

2.4.4 Tuning memory allocation
The memory allocation for each server instance can be changed by using the "Java 
Options" field in the Advance Tab of the Server.  Use the standard -msXX and 
-mxYY format for specifying those options. Tune down the memory allocation only 
if a lightly loaded ( < 50 agents ) interaction center is expected. Tune up the memory 
allocations if a heavily loaded ( > 500 agents ) is expected. 

Inbound Telephony 
Server

16M / 32M -ms16M -mx32M

Switch  Simulator 64M / 128M -ms64M -mx128M

Advanced Outbound 
Central Server

128M / 256M -ms128m -mx256M

Advanced Outbound 
Dial Server

128M / 256M -ms128m -mx256m

Server Type

Default Memory Settings

(Minimum / Maximum) Default Java Option
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Dependency Requirements and Verification

Topics include:

� Section 3.1, "Mandatory Dependencies"

� Section 3.2, "Conditional Dependencies"

3.1 Mandatory Dependencies
Mandatory dependencies must be implemented prior to implementing Oracle 
Interaction Center. They are required in order for Oracle Interaction Center to 
function.

The following mandatory dependencies apply to Oracle Interaction Center:

� Oracle CRM Foundation

See Also
� Section 3.2, "Conditional Dependencies"

3.2 Conditional Dependencies
Conditional dependencies provide desired functionality to Oracle Interaction 
Center but are not required for Oracle Interaction Center to function.

The following conditional dependencies apply to Oracle Interaction Center:

� Oracle TeleSales

� Oracle TeleService
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Conditional Dependencies
See Also
� Section 3.1, "Mandatory Dependencies"
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Implementation Overview

4.1 Process Description
Interaction Center Server Manager can be installed in the following ways:

� Perform a web tier installation of Oracle Applications

� Manually install Interaction Center Server Manager

Web Tier Rapid Install
Interaction Center Server Manager files, the Java Runtime Environment (JRE), and 
the apps.zip and jdbc111.zip files are installed during the web tier installation of 
Oracle Applications. Interaction Center Server Manager files are installed to 
<common_top>\admin\scripts (Windows NT) or <common_top>\admin\scripts 
(Unix).  On Windows NT, a service named "Oracle ICSM hostname" is registered.

There are no manual steps required with this type installation. However, this 
installation does require more disk space. The installation of any Oracle 
Applications server from a Rapid Install, even the web tier, will install the Oracle 
Application file system components. The web server code is not required to run 
Interaction Center Server Manager. Additionally, if there are multiple target 
machines, any patches to the Oracle Applications apps.zip or jdbc111.zip files will 
also have to be applied to every target machine using local copies of apps.zip and 
jdbc111.zip.

Manual Install
Manual installation involves:

� manually installing Interaction Center Server Manager

� manually installing Java Development Kit or Java Runtime Environment
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Implementation Task Sequence
� (Windows NT) registering Interaction Center Server Manager as a service

� manually creating a database connectivity file

� manually creating an Interaction Center Server Manager environment file

� linking to the apps.zip and jdbc111.zip files on the Oracle Applications server to 
which patches are most often applied

This type of installation does not require a lot of disk space. Most importantly, 
patches to the Oracle Applications apps.zip or jdbc111.zip files are immediately 
available to the target machine. However, this type of installation does involve 
manual setup.

See Also
Section 4.2, "Implementation Task Sequence"

4.2 Implementation Task Sequence
The following list is a high-level overview of the steps for implementing Oracle 
Interaction Center.

1. Downloading Interaction Center Server Manager Files

2. Creating an Environment File for the Interaction Center Server Manager Node

3. Registering Interaction Center Server Manager as an NT Service

4. Starting the Interaction Center Server Manager Node

5. Verifying the Interaction Center Server Manager Node

6. Creating a Single-Site Interaction Center or Creating a Multi-Site Interaction 
Center

See Also
Section 4.1, "Process Description"
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Implementation Tasks

Topics include:

� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

5.1 Defining an Administrator for Oracle Interaction Center
Use the following procedure to define an administrator for an Oracle interaction 
center.

Login
Self-Service Login URL

Responsibility
System Administrator

Prerequisites
� Review Oracle Applications Systems Administrator’s Guide.
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Defining an Administrator for Oracle Interaction Center
Steps
1. In the Navigator window, on the Functions tab, choose Security > User > 

Define.

The User window appears.

Use the following guidelines to define Oracle Applications usernames:

� Use only one word.

� Use only alphanumeric characters (’A’ through ’Z’, and ’0’ through ’9’).

� Use only the set of characters that your operating system supports for 
filenames.

2. In the User Name field, enter the name of the user.

The password is temporary. When the user signs on to Oracle Applications for 
the first time, the message “Your password has expired” appears and the user is 
prompted to set a new password.

Use the following guidelines to define Oracle Applications passwords:

� Use at least five characters and no more than 100 characters.

� Use only alphanumeric characters (’A’ through ’Z’, and ’0’ through ’9’).

3. In the Password field, enter the password for the user account and then press 
Tab.

The cursor remains in the Password field.

4. Enter the password again to verify it.

5. In the Responsibilities tab, add the following responsibility:

Responsibility Function Type

System Administrator Create user accounts. Self-Service

HRMS Manager, for example US HRMS 
Manager (if Oracle Human Resource 
Management System is installed)

Create an employee. Self-Service

CRM Resource Manager Create a CRM resource. Self-Service

Call Center HTML Administrator Administer an interaction center. HTML
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Implementing an Interaction Center Server Manager Node
Once the user record has been saved, you cannot delete an assigned 
responsibility. Oracle Applications maintains audit data for assigned 
responsibilities.

To deactivate an assigned responsibility, set the effective end date (in the 
Effective Dates - To field) of the assigned responsibility to the current date. To 
activate an assigned responsibility, clear or reset the effective end date.

6. From the File menu, choose Save.

You may close the Users window.

See Also
� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

5.2 Implementing an Interaction Center Server Manager Node
Perform the steps in the following table to implement an Interaction Center Server 
Manager. The Number column indicates the step order. The Required column 
indicates whether a step is required. The Description column describes a high-level 
step and, where applicable, provides a reference to a more detailed topic in this 
document. The Responsibility column indicates the Oracle Applications user 
account responsibility required to complete the step.

If you have defined an administrator for an Oracle interaction center, then that user 
has all of the responsibilities necessary to implement an Interaction Center Manager 
node. See Section 5.1, "Defining an Administrator for Oracle Interaction Center".

Number Required? Description Responsibility

❏ Step 1 Required Download the Interaction Center Server Manager files 
to the target machine.

See: Section 5.2.1, "Downloading Interaction Center 
Server Manager Files"

Call Center HTML 
Administration
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See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

❏ Step 2 Required Create and download a configured environment file to 
the target machine.

See: Section 5.2.2, "Creating an Environment File for the 
Interaction Center Server Manager Node"

Call Center HTML 
Administration

❏ Step 3 Required

(NT only)

Register Interaction Center Server Manager as an NT 
service.

See: Section 5.2.3, "Registering Interaction Center Server 
Manager as an NT Service"

Not Applicable

❏ Step 4 Required Start the Interaction Center Server Manager node.

See: Section 5.2.4, "Starting the Interaction Center Server 
Manager Node"

Not Applicable

❏ Step 5 Required Verify the Interaction Center Server Manager node in 
Oracle Applications.

See: Section 5.2.5, "Verifying the Interaction Center 
Server Manager Node"

Call Center HTML 
Administration

Number Required? Description Responsibility
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Implementing an Interaction Center Server Manager Node
5.2.1 Downloading Interaction Center Server Manager Files

Use the following procedure to download the files for Interaction Center Server 
Manager from Oracle Applications.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
None

Steps
1. Select the ICSM tab.

2. Click Setup.

3. In the Download and Install section, download the Interaction Center Server 
Manager .zip file for your operating system.

Note: During installation of the Oracle Applications web tier, 
Interaction Center Server Manager files are installed to <common_
top>\admin\scripts (Windows NT) or <common_
top>\admin\scripts (Unix). If you intend to use the web tier 
machine as the Interaction Center Server Manager node or if you 
have installed the Oracle Applications web tier on an additional 
target machine, then you do not have to download the Interaction 
Center Server Manager files. You may skip this step. 

For information about the installing Interaction Center Server 
Manager using the web tier installation of Oracle Applications, see 
Section 4.1, "Process Description".
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t

4. On the target machine, extract the .zip file.

Guidelines
The Interaction Center Server Manager .zip file for Windows NT contains the 
following files:

The Interaction Center Server Manager .zip file for Unix contains the following 
files:

Note: You can also download the Interaction Center Server 
Manager .zip files directly from your Oracle Applications web 
server (Rapid Install only). 

Use the following URLs:

/OA_HTML/download/ieo/ieoicsmnt.zip

/OA_HTML/download/ieo/ieoicsmunix.zip

File Description

\admin\scripts\ieoicsm.cmd This command file is used to start or stop an Interaction Center Server 
Manager Windows NT service, start or stop Interaction Center Server 
Manager in console mode, or start the Interaction Center Server Manager 
command line utility.

\admin\scripts\ieonticsm.cmd This command file is used to register or unregister Interaction Center 
Server Manager as a Windows NT service.

\admin\scripts\ieoenv.cmd This command files is used to set up the environment variables for 
Interaction Center Server Manager.

\admin\scripts\ieosvicsm.cmd This command file is used by Oracle Rapid Install, if applicable, during 
installation and deinstallation.

\util\OamkSvc.exe This program is used to register or unregister Interaction Center Server 
Manager as a Windows NT service.

File Description

/admin/scripts/ieoicsm.sh This command file is used to start or stop an Interaction Center Server 
Manager Windows NT service, start or stop Interaction Center Server 
Manager in console mode, or start the Interaction Center Server Manager 
command line utility.
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See Also
� Section 5.2.1, "Downloading Interaction Center Server Manager Files"

� Section 5.2.2, "Creating an Environment File for the Interaction Center Server 
Manager Node"

� Section 5.2.3, "Registering Interaction Center Server Manager as an NT Service"

� Section 5.2.4, "Starting the Interaction Center Server Manager Node"

� Section 5.2.5, "Verifying the Interaction Center Server Manager Node"

5.2.2 Creating an Environment File for the Interaction Center Server Manager Node

Use the following procedure to generate and download an Interaction Center Server 
Manager environment file from Oracle Applications.

/admin/scripts/ieoenv.sh This command files is used to set up the environment variables for 
Interaction Center Server Manager.

/admin/scripts/ieosvicsm.sh This command file is used by Oracle Rapid Install, if applicable, during 
installation and deinstallation.

/util/OamkSvc.exe This program is used to register or unregister Interaction Center Server 
Manager as a Windows NT service.

Note: During installation of the Oracle Applications web tier, 
Interaction Center Server Manager environment file is configured 
automatically. If you intend to use the web tier machine as the 
Interaction Center Server Manager node or if you have installed the 
Oracle Applications web tier on an additional target machine, then 
you do not have to create an environment file. You may skip this 
step. 

For information about the installing Interaction Center Server 
Manager using the web tier installation of Oracle Applications, see 
Section 4.1, "Process Description".

File Description
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Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
None

Steps
1. Select the ICSM tab.

1. Click Setup.

2. In the Generate Environment File section, enter the values for the environment 
variables.

The following table describes the environment variables.

Note: After the environment file has been installed or 
downloaded, you can directly edit the environment file (ieoenv.cmd 
for Windows NT or ieoenv.sh for Unix).

For information about modifying the environment file, see 
Section 5.3.3, "Modifying an Environment File for an Interaction 
Center Server Manager Node". 

Variable Description

IEO_COMM_TOP The directory to which the Interaction Center Server Manager 
.zip file was extracted.

IEO_DBC_FILE The absolute path to the database connectivity file.

You can use the Browse button to locate the file.

IEO_JRE The absolute path to the Java Development Kit executable 
(java.exe) file or Java Runtime Environment executable (jre.exe) 
file.

You can use the Browse button to locate the file.
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3. Select the platform.

4. Click download environment file.

The contents of the generated environment file are displayed in your browser.

5. Choose File > Save As and save the environment file as ieoenv.cmd in the 
<IEO_COMM_TOP>\admin\scripts directory.

6. If necessary, modify the environment file.

If you are using Java Development Kit or Java Runtime Environment 1.1.8, you 
must move the line:

set CLASSPATH=%CLASSPATH%;%IEO_JAVA_TOP%\jdbc111.zip

before the line:

set CLASSPATH=%CLASSPATH%;%IEO_JAVA_TOP%\jdbc12.zip

An example of an environment file is provided below.

IEO_JAVA_TOP The directory that contains both the apps.zip and jdbc111.zip 
files.

If you have created a link to files on an Oracle Applications 
server:

� use the UNC format for the network path (Windows NT) or 
the symbolic link (Unix).

� if the node and the Oracle Applications server are not on the 
same domain, then include the domain suffix.

IEO_IP The IP address of the machine that will run Interaction Center 
Server Manager.

IEO_HOST The name of the machine that will run Interaction Center Server 
Manager. This variable is use to create the name for the 
Windows NT service (Oracle ICSM <IEO_HOST>).

Note: This overwrites the default environment file that was 
installed with the Oracle Applications web-tier or extracted from 
the .zip file.

Variable Description
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Guidelines
The following is an example of an Interaction Center Server Manager environment 
file for Windows NT.

set IEO_JRE_HOME=C:\jdk1.1.8
set IEO_DBC_FILE=D:\icsm\icsm.dbc
set IEO_JAVA_TOP=D:\oa1156\java
set IEO_JRE=C:\jdk1.1.8\bin\java.exe
set IEO_IP=138.2.67.213
set IEO_HOST=stcsmith.us.oracle.com
set IEO_COMM_TOP=D:\icsm\
set CLASSPATH=.
set CLASSPATH=%CLASSPATH%;%IEO_JAVA_TOP%\jdbc12.zip
set CLASSPATH=%CLASSPATH%;%IEO_JAVA_TOP%\jdbc111.zip
set CLASSPATH=%CLASSPATH%;%IEO_JAVA_TOP%\xmlparserv2.zip
set CLASSPATH=%CLASSPATH%;%IEO_JAVA_TOP%\apps.zip
set CLASSPATH=%CLASSPATH%;%IEO_JRE_HOME%\classes
set CLASSPATH=%CLASSPATH%;%IEO_JRE_HOME%\lib
set CLASSPATH=%CLASSPATH%;%IEO_JRE_HOME%\lib\classes.zip
set CLASSPATH=%CLASSPATH%;%IEO_JRE_HOME%\lib\classes.jar
set CLASSPATH=%CLASSPATH%;%IEO_JRE_HOME%\lib\rt.jar
set CLASSPATH=%CLASSPATH%;%IEO_JRE_HOME%\lib\i18n.jar

See Also
� Section 5.2.1, "Downloading Interaction Center Server Manager Files"

� Section 5.2.2, "Creating an Environment File for the Interaction Center Server 
Manager Node"

� Section 5.2.3, "Registering Interaction Center Server Manager as an NT Service"

� Section 5.2.4, "Starting the Interaction Center Server Manager Node"

� Section 5.2.5, "Verifying the Interaction Center Server Manager Node"

5.2.3 Registering Interaction Center Server Manager as an NT Service
Use the following procedure to register Interaction Center Server Manager as an NT 
service.

Login
Not Applicable
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Responsibility
Not Applicable

Prerequisites
None

Steps
1. Open a command prompt window.

For example, in Windows NT:

a. Choose Start > Run.

b. Enter cmd.

c. Click OK.

2. Change to the scripts directory.

3. Register Interaction Center Server Manager as an NT service.

ieonticsm register

Guidelines
The following is an example of the output from the command prompt in Windows 
NT:

C:> cd D:\icsm\admin\scripts

D:\icsm\admin\scripts> ieonticsm.cmd register

D:\icsm\admin\scripts>echo off
ieo_home = ..\..
CLASSPATH = .;D:\oa1156\java\jdbc12.zip;D:\oa1156\java\jdbc111.zip;D:\oa1156\jav
a\xmlparserv2.zip;D:\oa1156\java\apps.zip;C:\jdk1.1.8\classes;C:\jdk1.1.8\lib;C:
\jdk1.1.8\lib\classes.zip;C:\jdk1.1.8\lib\classes.jar;C:\jdk1.1.8\lib\rt.jar;C:\
jdk1.1.8\lib\i18n.jar
Runnng command ..\..\util\OamkSvc.exe -si "Oracle ICSM stcsmith.us.oracle.com" -
e -a -c "C:\jdk1.1.8\bin\java.exe -ms8M -mx16M oracle.apps.ieo.icsm.server.Main
-dbc D:\icsm\icsm.dbc -home D:\icsm\\admin\scripts      "

Note: Configure the service to log on to a Windows NT user 
account that has access to the network path (IEO_JAVA_TOP) that 
points to the apps.zip and jdbc111.zip files.
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Capture Environment - TRUE
Automatic Startup   - TRUE
Set dependency on   - None
Startup username    - None
Program launched    - C:\jdk1.1.8\bin\java.exe -ms8M -mx16M oracle.apps.ieo.icsm
.server.Main -dbc D:\icsm\icsm.dbc -home D:\icsm\\admin\scripts
Program to kill     - None
Terminate All       - FALSE

Service "Oracle ICSM stcsmith.us.oracle.com" successfully created. Environment r
ecorded in oaMkSvc.log.
 Change service parameters from ControlPanel.

ieonticsm.cmd exiting with status 1

See Also
� Section 5.2.1, "Downloading Interaction Center Server Manager Files"

� Section 5.2.2, "Creating an Environment File for the Interaction Center Server 
Manager Node"

� Section 5.2.3, "Registering Interaction Center Server Manager as an NT Service"

� Section 5.2.4, "Starting the Interaction Center Server Manager Node"

� Section 5.2.5, "Verifying the Interaction Center Server Manager Node"

5.2.4 Starting the Interaction Center Server Manager Node
The Interaction Center Server Manager node is started at the command line or, if 
registered as a Windows NT service, as a service.

Use the following procedure to start the Interaction Center Server Manager node.

Login
Not Applicable

Responsibility
Not Applicable
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Prerequisites
None

Steps
1. Open a command prompt window.

For example, in Windows NT:

a. Choose Start > Run.

b. Enter cmd.

c. Click OK.

2. Change to the scripts directory.

3. Start Interaction Center Server Manager.

For a complete list of command line parameters for Interaction Center Server 
Manager, see Appendix C.

� To start Interaction Center Server Manager at the command line, enter:

ieoicsm start

� To start Interaction Center Server Manager process in console mode (Windows 
NT only) at the command line, enter:

ieoicsm console_start

� To start Interaction Center Server Manger in the Windows NT Services window:

a. Choose Start > Settings > Control Panel.

b. Double-click Services.

The Services window appears.

c. Click Oracle ICSM <machinename>.

d. Click Start.

Windows NT attempts to start the service.

e. Click Close.

Guidelines
The following is an example of the output from the command prompt in Windows 
NT:
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C:> cd D:\icsm\admin\scripts

D:\icsm\admin\scripts> ieoicsm.cmd start

D:\icsm\admin\scripts>echo off
***************************
You are running ieoicsm.cmd
***************************
Tue 10/23/2001
10:03p
ieo_home = ..\..
"Starting Oracle ICSM"
The Oracle ICSM stcsmith.us.oracle.com service is starting.
The Oracle ICSM stcsmith.us.oracle.com service was started successfully.

ieoicsm.cmd exiting with status 0

See Also
� Section 5.2.1, "Downloading Interaction Center Server Manager Files"

� Section 5.2.2, "Creating an Environment File for the Interaction Center Server 
Manager Node"

� Section 5.2.3, "Registering Interaction Center Server Manager as an NT Service"

� Section 5.2.4, "Starting the Interaction Center Server Manager Node"

� Section 5.2.5, "Verifying the Interaction Center Server Manager Node"

5.2.5 Verifying the Interaction Center Server Manager Node
Use the following procedure to verify the implementation of an Interaction Center 
Server Manager node.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
None
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Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears. Verify that the target machine appears in the list.

3. Click the node name.

The Node Details page appears. Verify that the status of the node is Up.

See Also
� Section 5.2.1, "Downloading Interaction Center Server Manager Files"

� Section 5.2.2, "Creating an Environment File for the Interaction Center Server 
Manager Node"

� Section 5.2.3, "Registering Interaction Center Server Manager as an NT Service"

� Section 5.2.4, "Starting the Interaction Center Server Manager Node"

� Section 5.2.5, "Verifying the Interaction Center Server Manager Node"

5.3 Administering an Interaction Center Server Manager Node
Topics include:

� Section 5.3.1, "Viewing the Status of an Interaction Center Server Manager 
Node"

� Section 5.3.2, "Stopping an Interaction Center Server Manager Node"

� Section 5.3.3, "Modifying an Environment File for an Interaction Center Server 
Manager Node"

� Section 5.3.4, "Adding an IP Address to the Node IP Address List (Multihomed 
Nodes)"

� Section 5.3.5, "Specifying an IP Address for a Server Process (Multihomed 
Nodes)"

� Section 5.3.6, "Removing an Interaction Center Server Manager Node"

See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"
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� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

5.3.1 Viewing the Status of an Interaction Center Server Manager Node
Use this procedure to the view the status of an Interaction Center Server Manager 
node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Click a node name.

The Node Details page appears. The status of Interaction Center Server 
Manager is displayed at the top of the page. The following table describes the 
statuses.

t

Status Description

Down Interaction Center Server Manager is not running on the target 
machine.

Up Interaction Center Server Manager is running on the target 
machine.
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See Also
� Section 5.3.2, "Stopping an Interaction Center Server Manager Node"

� Section 5.3.3, "Modifying an Environment File for an Interaction Center Server 
Manager Node"

� Section 5.3.4, "Adding an IP Address to the Node IP Address List (Multihomed 
Nodes)"

� Section 5.3.5, "Specifying an IP Address for a Server Process (Multihomed 
Nodes)"

� Section 5.3.6, "Removing an Interaction Center Server Manager Node"

5.3.2 Stopping an Interaction Center Server Manager Node
Use the following procedure to stop an Interaction Center Server Manager node.

Login
Not Applicable

Responsibility
Not Applicable

Prerequisites
None

Steps
1. Open a command prompt window.

For example, in Windows NT:

a. Choose Start > Run.

b. Enter cmd.

c. Click OK.

2. Change to the scripts directory.

3. Stop Interaction Center Server Manager.

For a complete list of command line parameters for Interaction Center Server 
Manager, see Appendix C.
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� To stop the Interaction Center Server Manager process at the command line, 
enter:

ieoicsm stop

� To stop the Interaction Center Server Manager process in console mode 
(Windows NT only) at the command line, enter:

ieoicsm console_stop

� To stopt Interaction Center Server Manger in the Windows NT Services 
window:

a. Choose Start > Settings > Control Panel.

b. Double-click Services.

The Services window appears.

c. Click Oracle ICSM <machinename>.

d. Click Stop.

Windows NT attempts to start the service.

e. Click Close.

Guidelines
The following is an example of the output from the command prompt in Windows 
NT:

C:> cd D:\icsm\admin\scripts

D:\icsm\admin\scripts> ieoicsm.cmd stop

D:\icsm\admin\scripts>echo off
***************************
You are running ieoicsm.cmd
***************************
Tue 10/23/2001
10:01p
ieo_home = ..\..
"Stopping Oracle ICSM"

Note: the Stop button is not available if the service is running.
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The Oracle ICSM stcsmith.us.oracle.com service is stopping.
The Oracle ICSM stcsmith.us.oracle.com service was stopped successfully.

ieoicsm.cmd exiting with status 0

See Also
� Section 5.3.1, "Viewing the Status of an Interaction Center Server Manager 

Node"

� Section 5.3.3, "Modifying an Environment File for an Interaction Center Server 
Manager Node"

� Section 5.3.4, "Adding an IP Address to the Node IP Address List (Multihomed 
Nodes)"

� Section 5.3.5, "Specifying an IP Address for a Server Process (Multihomed 
Nodes)"

� Section 5.3.6, "Removing an Interaction Center Server Manager Node"

5.3.3 Modifying an Environment File for an Interaction Center Server Manager Node
After the environment file has been installed or downloaded, you can directly edit 
the environment file (ieoenv.cmd for Windows NT or ieoenv.sh for Unix).

Use this procedure to modify the environment variables for an Interaction Center 
Server Manager node.

Note: If you are using Java Development Kit or Java Runtime 
Environment 1.1.8, you must move the line:

set CLASSPATH=%CLASSPATH%;%IEO_JAVA_
TOP%\jdbc111.zip

before the line:

set CLASSPATH=%CLASSPATH%;%IEO_JAVA_
TOP%\jdbc12.zip

An example of an environment file is provided in Section 5.2.2, 
"Creating an Environment File for the Interaction Center Server 
Manager Node".
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Login
Not Applicable

Responsibility
Not Applicable

Prerequisites
None

Steps
1. If Interaction Center Server Manager is registered as an NT service, unregister 

the service.

ieonticsm unregister

2. Edit the ieoenv file.

For information about the environment variables, see Section 5.2.2, "Creating an 
Environment File for the Interaction Center Server Manager Node".

3. Register the NT service.

See Section 5.2.3, "Registering Interaction Center Server Manager as an NT 
Service".

See Also
� Section 5.3.1, "Viewing the Status of an Interaction Center Server Manager 

Node"

� Section 5.3.2, "Stopping an Interaction Center Server Manager Node"

� Section 5.3.4, "Adding an IP Address to the Node IP Address List (Multihomed 
Nodes)"

� Section 5.3.5, "Specifying an IP Address for a Server Process (Multihomed 
Nodes)"

� Section 5.3.6, "Removing an Interaction Center Server Manager Node"

5.3.4 Adding an IP Address to the Node IP Address List (Multihomed Nodes)
An Interaction Center Server Manager node may have more than one IP address. A 
machine with more that one IP address is known as a multihomed machine. 
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Interaction Center Server Manager discovers only one of those IP addresses. The 
remaining IP addresses must be manually added to the IP address list for the node.

Use this procedure to add additional IP addresses to the list of IP addresses for the 
Interaction Center Server Manager node.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Implement Interaction Center Server Manager.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Click the node name.

The Node Details page appears.

4. Click Advanced.

5. In the Add field, enter an IP address for the node. 

6. Click Update.

The IP address is added to the list of IP addresses for the node.

See Also
� Section 5.3.1, "Viewing the Status of an Interaction Center Server Manager 

Node"

� Section 5.3.2, "Stopping an Interaction Center Server Manager Node"

� Section 5.3.3, "Modifying an Environment File for an Interaction Center Server 
Manager Node"

� Section 5.3.5, "Specifying an IP Address for a Server Process (Multihomed 
Nodes)"
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� Section 5.3.6, "Removing an Interaction Center Server Manager Node"

5.3.5 Specifying an IP Address for a Server Process (Multihomed Nodes)
An Interaction Center Server Manager node may have more than one IP address. A 
machine with more that one IP address is known as a multihomed machine. 
Interaction Center Server Manager discovers only one of those IP addresses. The 
remaining IP addresses must be manually added to the IP address list for the node.

Use this procedure to select an IP address in the IP address list for a specific server 
process assigned to an Interaction Center Server Manager node.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Implement Interaction Center Server Manager.

� Add additional IP addresses to the node IP address list.

� Stop Interaction Center Server Manager.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Click a node name.

The Node Details page appears.

4. In the IP Address column, do one of the following:

� Leave the IP Address field blank.

Interaction Center Server Manager will use one of the available IP 
addresses in the list. If there is only one IP address, the Interaction Center 
Server Manager uses that IP address.

� Select an IP address.
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When the server process is running, Interaction Center Server Manager 
communicates using the selected IP address.

5. Click Update.

The Node Details page is refreshed.

See Also
� Section 5.3.1, "Viewing the Status of an Interaction Center Server Manager 

Node"

� Section 5.3.2, "Stopping an Interaction Center Server Manager Node"

� Section 5.3.3, "Modifying an Environment File for an Interaction Center Server 
Manager Node"

� Section 5.3.4, "Adding an IP Address to the Node IP Address List (Multihomed 
Nodes)"

� Section 5.3.6, "Removing an Interaction Center Server Manager Node"

5.3.6 Removing an Interaction Center Server Manager Node
Use this procedure to remove an interaction center server node. All server processes 
on the node remain in the server group without an assigned node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Stop any server processes that are running on the node.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Select the Remove checkbox for the node that you want to remove.
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4. Click Update.

The node is removed and the Node List page is refreshed.

See Also
� Section 5.3.1, "Viewing the Status of an Interaction Center Server Manager 

Node"

� Section 5.3.2, "Stopping an Interaction Center Server Manager Node"

� Section 5.3.3, "Modifying an Environment File for an Interaction Center Server 
Manager Node"

� Section 5.3.4, "Adding an IP Address to the Node IP Address List (Multihomed 
Nodes)"

� Section 5.3.5, "Specifying an IP Address for a Server Process (Multihomed 
Nodes)"

5.4 Implementing a Single-Site Interaction Center
Perform the steps in the following table to implement a single-site interaction 
center. The Number column indicates the step order. The Required column indicates 
whether a step is required. The Description column describes a high-level step and, 
where applicable, provides a reference to a more detailed topic in this document. 
The Responsibility column indicates the Oracle Applications user account 
responsibility required to complete the step.

If you have defined an administrator for an Oracle interaction center, then that user 
has all of the responsibilities necessary to implement a single-site interaction center. 
See Section 5.1, "Defining an Administrator for Oracle Interaction Center".

Note: This does not remove the Interaction Center Server 
Manager files from the node. If you start the Interaction Center 
Server Manager node, then the node will reappear in the node list. 
See Section 5.2.4, "Starting the Interaction Center Server Manager 
Node".
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See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

5.4.1 Creating a Single-Site Interaction Center
A typical single-site interaction center for Advanced Inbound consists of: 

� one Inbound Telephony Server 

� one Interaction Queue and Distribution server 

� one or more Telephony Manager servers

� one or more Universal Work Queue servers

� one or more Routing servers

� (optionally) one Switch Simulator server

Use this procedure to create a single-site Oracle interaction center for Advanced 
Inbound.

Number Required? Description Responsibility

❏ Step 1 Required Create a single-site interaction center.

See: Section 5.4.1, "Creating a Single-Site Interaction 
Center"

Call Center HTML 
Administration

❏ Step 2 Required Implement Advanced Inbound.

See: Oracle Advanced Inbound Implementation Guide

Not Applicable

❏ Step 3 Optional Implement Advanced Outbound.

See: Oracle Advanced Outbound Implementation Guide

Not Applicable

❏ Step 4 Required Implement Universal Work Queue.

See: Oracle Universal Work Queue Implementation Guide

Not Applicable
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Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Oracle Call Center Connectors.

� Install and configure an Interaction Center Server Manager node.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click Create.

The Server Group Details page appears.

4. Enter the details about the server group.

a. Enter a unique name for the server group.

b. Optionally, in the Location field, enter the location of the server group.

This field is for informational purposes only.

c. Optionally, in the Description field, enter a description of the server group.

This field is for informational purposes only.

d. Leave the Super Group field blank.

The super group identifies the global server group for a multi-site 
interaction center.

e. In the Default Node field, select the Interaction Center Server Manager 
node for the interaction center server processes in the server group.

The default node is used during a typical or custom server group 
configuration. In a typical or custom server group configuration, server 
processes are created when the server group is created. They are assigned to 
the default Interaction Center Server Manager node. You can modify the 
node assignment after the server group is created.
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f. In the Server Configuration field, select a configuration type for creation of 
the server group.

You have the following options:

5. Click Submit.

If the server configuration is None or Typical, then the server group is created 
and the Server Group Details page is refreshed.

If the server configuration is Custom, then the Server page appears. Enter the 
general details about the server processes and then click Submit. The Server 
Group Details page is refreshed.

In the Server Group Details page, a list of server processes appears under the 
Servers section. For information about modifying the server group, see 
Section 5.6, "Administering an Interaction Center".

Configuration Type Description

Typical The server group is created with the default set of server 
processes necessary to implement a single-site interaction center 
for Advanced Inbound:

� Interaction Queueing and Distribution 
(<servergroupname>_IQD)

� Inbound Telephony Server (<servergroupname>_ITS)

� Routing Server (<servergroupname>_ORS)

� Telephony Manager (<servergroupname>_OTM)

� Switch Simulator (<servergroupname>_SWITCH)

� Universal Work Queue Server (<servergroupname>_UWQ)

You will not be able to modify the server process names or types. 
Server processes must be added or removed from the Server 
Group Details page.

Custom The Server page appears with the default set of server processes 
necessary to implement a single-site interaction center for 
Advanced Inbound (see Typical for a list of server processes).

Use the Server page to add or remove server processes and to 
modify the general details about each server process before it is 
added to the server group.

None When the server group is created, no server processes are added 
to the server group. You must manually add any server process 
to the server group.
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6. If you make any changes, then click Update.

5.5 Implementing a Multi-Site Interaction Center
Perform the steps in the following table to implement a multi-site interaction center. 
The Number column indicates the step order. The Required column indicates 
whether a step is required. The Description column describes a high-level step and, 
where applicable, provides a reference to a more detailed topic in this document. 
The Responsibility column indicates the Oracle Applications user account 
responsibility required to complete the step.

If you have defined an administrator for an Oracle interaction center, then that user 
has all of the responsibilities necessary to implement a multi-site interaction center. 
See Section 5.1, "Defining an Administrator for Oracle Interaction Center".

See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

Number Required? Description Responsibility

❏ Step 1 Required Create a multi-site interaction center.

See: Section 5.5.1, "Creating a Multi-Site Interaction 
Center"

Call Center HTML 
Administration

❏ Step 2 Required Implement Advanced Inbound.

See: Oracle Advanced Inbound Implementation Guide

Not Applicable

❏ Step 3 Optional Implement Advanced Outbound.

See: Oracle Advanced Outbound Implementation Guide

Not Applicable

❏ Step 4 Required Implement Universal Work Queue.

See: Oracle Universal Work Queue Implementation Guide

Not Applicable
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5.5.1 Creating a Multi-Site Interaction Center
A typical multi-site interaction center for Advanced Inbound consists of a global 
site and two or more local sites.

Topics include:

� Section 5.5.1.1, "Creating a Global Site for a Multi-Site Interaction Center"

� Section 5.5.1.2, "Creating a Local Site for a Multi-Site Interaction Center"

5.5.1.1 Creating a Global Site for a Multi-Site Interaction Center
A global site in a multi-site interaction center typically consists of: 

� one Interaction Queue and Distribution server 

� one or more Routing servers

Use this procedure to create a global site for a multi-site interaction center.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Oracle Call Center Connectors.

� Install and configure an Interaction Center Server Manager node.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click Create.

The Server Group Details page appears.

4. Enter the details about the server group.

a. Enter a unique name for the server group.
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b. Optionally, in the Location field, enter the location of the server group.

This field is for informational purposes only.

c. Optionally, in the Description field, enter a description of the server group.

This field is for informational purposes only.

d. Leave the Super Group field blank.

The super group identifies the global server group for a multi-site 
interaction center.

e. In the Default Node field, select the Interaction Center Server Manager 
node for the interaction center server processes in the server group.

The default node is used during a typical or custom server group 
configuration. In a typical or custom server group configuration, server 
processes are created when the server group is created. They are assigned to 
the default Interaction Center Server Manager node. You can modify the 
node assignment after the server group is created.

f. In the Server Configuration field, select a configuration type for creation of 
the server group.

You have the following options:

Configuration Type Description

Typical The server group is created with the default set of server 
processes necessary to implement a single-site interaction center 
for Advanced Inbound:

� Interaction Queueing and Distribution 
(<servergroupname>_IQD)

� Inbound Telephony Server (<servergroupname>_ITS)

� Routing Server (<servergroupname>_ORS)

� Telephony Manager (<servergroupname>_OTM)

� Switch Simulator (<servergroupname>_SWITCH)

� Universal Work Queue Server (<servergroupname>_UWQ)

You will not be able to modify the server process names or types. 
Server processes must be added or removed from the Server 
Group Details page.
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5. Click Submit.

If the server configuration is None or Typical, then the server group is created 
and the Server Group Details page is refreshed.

If the server configuration is Custom, then the Server page appears. Enter the 
general details about the server processes and then click Submit. The Server 
Group Details page is refreshed.

In the Server Group Details page, a list of server processes appears under the 
Servers section. For information about modifying the server group, see 
Section 5.6, "Administering an Interaction Center".

6. Ensure that you have only one Interaction Queue and Distribution server and 
one Routing server in this global server group.

7. If you make any changes, then click Update.

See Also
� Section 5.5.1.2, "Creating a Local Site for a Multi-Site Interaction Center"

5.5.1.2 Creating a Local Site for a Multi-Site Interaction Center
A local site in a multi-site interaction center typically consists of: 

� one Inbound Telephony Server 

� one or more Telephony Manager servers

� one or more Universal Work Queue servers

Use this procedure to create a local site for a multi-site interaction center.

Custom The Server page appears with the default set of server processes 
necessary to implement a single-site interaction center for 
Advanced Inbound (see Typical for a list of server processes).

Use the Server page to add or remove server processes and to 
modify the general details about each server process before it is 
added to the server group.

None When the server group is created, no server processes are added 
to the server group. You must manually add any server process 
to the server group.

Configuration Type Description
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Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Oracle Call Center Connectors.

� Install and configure an Interaction Center Server Manager node.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click Create.

The Server Group Details page appears.

4. Enter the details about the server group.

a. Enter a unique name for the server group.

b. Optionally, in the Location field, enter the location of the server group.

This field is for informational purposes only.

c. Optionally, in the Description field, enter a description of the server group.

This field is for informational purposes only.

d. In the Super Group field, select the name of the global server group for the 
multi-site interaction center.

e. In the Default Node field, select the Interaction Center Server Manager 
node for the interaction center server processes in the server group.

The default node is used during a typical or custom server group 
configuration. In a typical or custom server group configuration, server 
processes are created when the server group is created. They are assigned to 
the default Interaction Center Server Manager node. You can modify the 
node assignment after the server group is created.
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f. In the Server Configuration field, select a configuration type for creation of 
the server group.

You have the following options:

5. Click Submit.

If the server configuration is None or Typical, then the server group is created 
and the Server Group Details page is refreshed.

If the server configuration is Custom, then the Server page appears. Enter the 
general details about the server processes and then click Submit. The Server 
Group Details page is refreshed.

In the Server Group Details page, a list of server processes appears under the 
Servers section. For information about modifying the server group, see 
Section 5.6, "Administering an Interaction Center".

Configuration Type Description

Typical The server group is created with the default set of server 
processes necessary to implement a single-site interaction center 
for Advanced Inbound:

� Interaction Queueing and Distribution 
(<servergroupname>_IQD)

� Inbound Telephony Server (<servergroupname>_ITS)

� Routing Server (<servergroupname>_ORS)

� Telephony Manager (<servergroupname>_OTM)

� Switch Simulator (<servergroupname>_SWITCH)

� Universal Work Queue Server (<servergroupname>_UWQ)

You will not be able to modify the server process names or types. 
Server processes must be added or removed from the Server 
Group Details page.

Custom The Server page appears with the default set of server processes 
necessary to implement a single-site interaction center for 
Advanced Inbound (see Typical for a list of server processes).

Use the Server page to add or remove server processes and to 
modify the general details about each server process before it is 
added to the server group.

None When the server group is created, no server processes are added 
to the server group. You must manually add any server process 
to the server group.
Implementation Tasks 5-33



Administering an Interaction Center
6. Ensure that you have one Inbound Telephony Server, one or more Telephony 
Manager servers, and one or more Universal Work Queue servers is this local 
server group.

You should not have an Interaction Queueing and Distribution server or any 
Routing servers in a local server group in a multi-site interaction center.

7. If you make any changes, then click Update.

See Also
� Section 5.5.1.1, "Creating a Global Site for a Multi-Site Interaction Center"

5.6 Administering an Interaction Center
Topics include:

� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"

See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

5.6.1 Viewing the Status of a Server Process
Topics include:
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� Section 5.6.1.1, "Viewing the Status of a Server Process in a Server Group"

� Section 5.6.1.2, "Viewing the Status of a Server Process on an Interaction Center 
Server Manager Node"

See Also
� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"

5.6.1.1 Viewing the Status of a Server Process in a Server Group
Use this procedure to the status of an interaction center server process in a server 
group.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.
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The Server Group Details page appears.The status of each server process 
assigned to the node is displayed in the Servers area in the Status column. The 
following table describes the statuses.

t

See Also
� Section 5.6.1.2, "Viewing the Status of a Server Process on an Interaction Center 

Server Manager Node"

5.6.1.2 Viewing the Status of a Server Process on an Interaction Center Server 
Manager Node
Use this procedure to the status of an interaction center server process on an 
Interaction Center Server Manager node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Click a node name.

Status Description

Red flag The server process is not running.

Green flag The server process is running.

Red circle with a white 
"x"

The Interaction Center Server Manager node is not running or 
the server process is not assigned to an Interaction Center Server 
Manager node.
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The Node Details page appears. The status of each server process assigned to 
the node is displayed in the Servers area in the Status column. The following 
table describes the statuses.

t

See Also
� Section 5.6.1.1, "Viewing the Status of a Server Process in a Server Group"

5.6.2 Adding a Server Process to an Interaction Center Server Group
Use this procedure to add a server process to an interaction center server group.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure an Interaction Center Server Manager node.

� Create an interaction center server group.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.

The Server Group Details page appears.

Status Description

Red flag The server process is not running.

Green flag The server process is running.

Red circle with a white 
"x"

The Interaction Center Server Manager node is not running or 
the server process is not assigned to an Interaction Center Server 
Manager node.
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4. In the Servers area, click Create.

The Server Details - General page appears.

5. Enter the general details about the server.

a. Enter a unique name for the server.

b. In the Type Name field, select the server type.

c. Optionally, in the Location field, enter the location of the server.

This field is for informational purposes only.

d. Optionally, in the Description field, enter a description of the server.

This field is for informational purposes only.

e. From the Member Server Group list, select a server group for the server 
process.

f. In the Node Assignment field, select the Interaction Center Server Manager 
node to which the server process will be assigned.

g. Click Save.

The Server Details - General page is refreshed.

6. If you want to specify standard parameters for the server process, then click 
Parameters.

The Server Details - Parameters page appears.

a. In the Parameter Value field, enter a value for the parameter.

For a list of server process parameters, see Appendix B, "Oracle Interaction 
Center Server Parameters".

b. Click Update.

The Server Details - Parameters page is refreshed.

7. If you want to specify java options or command line parameters, then click 
Advanced.

The Server Details - Advanced page appears.

Note: The Using Server Group field is reserved for future use. 
Leave it blank.
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a. If you want to specify java options for the server process, then enter the 
parameters in the Java Options field.

b. If you want to specify command line parameters for the server process, then 
enter the parameters in the Server Arguments field.

c. Click Update.

The Servers Details - Advanced page is refreshed.

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"

5.6.3 Moving a Server Process to a Different Node
Topics include:

� Section 5.6.3.1, "Changing Server Process Node Assignments in a Server Group"

� Section 5.6.3.2, "Changing Server Process Node Assignments on a Node"

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"
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5.6.3.1 Changing Server Process Node Assignments in a Server Group
Interaction center server processes can run on any Interaction Center Server 
Manager node. Use this procedure to change the node assignment for server 
processes in a server group. 

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure an Interaction Center Server Manager node.

� Create an interaction center server group.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.

The Server Group Details page appears.

4. In the Servers area, click Create.

The Server Details - General page appears.

5. In the Node Assignment field, select the Interaction Center Server Manager 
node to which the server process will be assigned.

6. Click Save.

The Server Details - General page is refreshed.

See Also
� Section 5.6.3.2, "Changing Server Process Node Assignments on a Node"
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5.6.3.2 Changing Server Process Node Assignments on a Node
Interaction center server processes can run on any Interaction Center Server 
Manager node. Use this procedure to change the node assignment for server 
processes on a node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Stop any server processes that you want to move.

Steps
1. Select the ICSM tab.

1. Click Nodes.

The Node List page appears.

2. Click the name of the Interaction Center Server Manager node to which you 
wish to move the server processes.

The Node Details - General page appears.

3. Click Assignments.

The Node Details - Assignment page appears.

4. In the Select Server Group field, select the server group from which you wish to 
move server processes.

The Available Servers list displays the server processes in the server group that 
are not assigned to the selected node.

5. In the Available Servers list, select the server processes that you wish to assign 
to the selected node.

Press CTRL and click the mouse buttonto select multiple server processes.

6. Click the left arrow button to assign the server processes to the node.

7. Click Update.
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See Also
� Section 5.6.3.2, "Changing Server Process Node Assignments on a Node"

5.6.4 Configuring Interaction Center Server Process Parameters
Use this procedure to configure the parameters for a server in an Oracle interaction 
center server group.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Create a server group.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click the server group name.

The Server Group Details page displays.

4. In the Servers area, click a server name.

The Server Details - General page appears for the specified server.

5. Click Parameters.

The Server Details - Parameters page appears.

6. In the Parameter Value field, enter a value for the parameter.

For a list of server process parameters, see Appendix B, "Oracle Interaction 
Center Server Parameters".

Note: Save your changes before selecting another server from the 
Select Server Group field.
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7. Click Update.

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"

5.6.5 Starting Server Processes
Topics include:

� Section 5.6.5.1, "Starting All Server Processes in an Interaction Center Server 
Group"

� Section 5.6.5.2, "Starting a Specific Server Process in an Interaction Center 
Server Group"

� Section 5.6.5.3, "Starting a Specific Server Process on an Interaction Center 
Server Manager Node"

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"
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5.6.5.1 Starting All Server Processes in an Interaction Center Server Group
Use this procedure to start all interaction center server processes in a server group. 
Server processes are automatically started in the correct order.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

� Create an interaction center server group.

� Assign server processes in the server group to Interaction Center Server 
Manager nodes.

� Start the Interaction Center Server Manager nodes to which the server processes 
are assigned.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.

The Server Group Details page appears.

4. In the Server Group Details area, select Start and then click Submit.

It may take several minutes to start the server processes. To view the current 
status during startup, refresh the browser several times.

As the server processes are starting up, "Starting" is displayed in the Stop/Start 
column. The status of each server process is displayed in the Servers area in the 
Status column. 

See Also
� Section 5.6.5.2, "Starting a Specific Server Process in an Interaction Center 

Server Group"
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� Section 5.6.5.3, "Starting a Specific Server Process on an Interaction Center 
Server Manager Node"

5.6.5.2 Starting a Specific Server Process in an Interaction Center Server Group
Use this procedure to start a specific interaction center server process in a server 
group.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

� Create an interaction center server group.

� Assign server processes in the server group to Interaction Center Server 
Manager nodes.

� Start the Interaction Center Server Manager nodes to which the server processes 
are assigned.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.

The Server Group Details page appears.

4. In the Servers area, in the Stop/Start column, click Start for the server process 
that you want to start.

It may take several minutes to start the server process. To view the current 
status during startup, refresh the browser several times.

As the server process is starting up, "Starting" is displayed in the Stop/Start 
column. The status of each server process is displayed in the Servers area in the 
Status column. 
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See Also
� Section 5.6.5.1, "Starting All Server Processes in an Interaction Center Server 

Group"

� Section 5.6.5.3, "Starting a Specific Server Process on an Interaction Center 
Server Manager Node"

5.6.5.3 Starting a Specific Server Process on an Interaction Center Server 
Manager Node
Use this procedure to start a specific interaction center server process on an 
Interaction Center Server Manager node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

� Create an interaction center server group.

� Assign server processes in the server group to Interaction Center Server 
Manager nodes.

� Start the Interaction Center Server Manager nodes to which the server processes 
are assigned.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Click a node name.

The Node Details page appears.

4. In the Stop/Start column, click Start for the server process that you want to 
start.
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It may take several minutes to start the server process. To view the current 
status during startup, refresh the browser several times.

As the server process is starting up, "Starting" is displayed in the Stop/Start 
column. The status of each server process is displayed in the Servers area in the 
Status column. 

See Also
� Section 5.6.5.1, "Starting All Server Processes in an Interaction Center Server 

Group"

� Section 5.6.5.2, "Starting a Specific Server Process in an Interaction Center 
Server Group"

5.6.6 Stopping Server Processes
Topics include:

� Section 5.6.6.1, "Stopping All Server Processes in an Interaction Center Server 
Group"

� Section 5.6.6.2, "Stopping a Specific Server Process in an Interaction Center 
Server Group"

� Section 5.6.6.3, "Stopping a Specific Server Process on an Interaction Center 
Server Manager Node"

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.7, "Removing a Server Process"

� Section 5.6.8, "Removing an Interaction Center Server Group"

5.6.6.1 Stopping All Server Processes in an Interaction Center Server Group
Use this procedure to start all interaction center server processes in a server group.
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Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Install and configure Interaction Center Server Manager.

� Create an interaction center server group.

� Assign server processes in the server group to Interaction Center Server 
Manager nodes.

� Start the Interaction Center Server Manager nodes to which the server processes 
are assigned.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.

The Server Group Details page appears.

4. In the Server Group Details area, select Stop and then click Submit.

It may take several minutes to stop the server processes. To view the current 
status during shutdown, refresh the browser several times.

As the server processes are shutting down, "Stopping" is displayed in the 
Stop/Start column. The status of each server process is displayed in the Servers 
area in the Status column. 

See Also
� Section 5.6.6.2, "Stopping a Specific Server Process in an Interaction Center 

Server Group"

� Section 5.6.6.3, "Stopping a Specific Server Process on an Interaction Center 
Server Manager Node"
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5.6.6.2 Stopping a Specific Server Process in an Interaction Center Server 
Group
Use this procedure to stop a specific interaction center server process in a server 
group.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Start the Interaction Center Server Manager nodes to which the server process is 

assigned.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.

3. Click a server group name.

The Server Group Details page appears.

4. In the Servers area, in the Stop/Start column, click Stop for the server process 
that you want to stop.

It may take several minutes to stop the server process. To view the current 
status during shutdown, refresh the browser several times.

As the server process is shutting down, "Stopping" is displayed in the 
Stop/Start column. The status of each server process is displayed in the Servers 
area in the Status column. 

See Also
� Section 5.6.6.1, "Stopping All Server Processes in an Interaction Center Server 

Group"

� Section 5.6.6.3, "Stopping a Specific Server Process on an Interaction Center 
Server Manager Node"
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5.6.6.3 Stopping a Specific Server Process on an Interaction Center Server 
Manager Node
Use this procedure to stop a specific interaction center server process on an 
Interaction Center Server Manager node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Start the Interaction Center Server Manager nodes to which the server process is 

assigned.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears.

3. Click a node name.

The Node Details page appears.

4. In the Stop/Start column, click Stop for the server process that you want to 
stop.

It may take several minutes to stop the server process. To view the current 
status during shutdown, refresh the browser several times.

As the server process is shutting down, "Stopping" is displayed in the 
Stop/Start column. The status of each server process is displayed in the Servers 
area in the Status column. 

See Also
� Section 5.6.6.1, "Stopping All Server Processes in an Interaction Center Server 

Group"

� Section 5.6.6.2, "Stopping a Specific Server Process in an Interaction Center 
Server Group"
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5.6.7 Removing a Server Process
Topics include:

� Section 5.6.7.1, "Removing a Server Process from an Interaction Center Server 
Group"

� Section 5.6.7.2, "Removing a Server Process from an Interaction Center Server 
Manager Node"

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"

� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.8, "Removing an Interaction Center Server Group"

5.6.7.1 Removing a Server Process from an Interaction Center Server Group
Use this procedure to remove an interaction center server process from a server 
group.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Stop the server process if it is running.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears.
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3. Click a server group name.

The Server Group Details page appears. 

4. In the Servers area, select the Remove checkbox for the server process that you 
want to remove.

5. Click Update.

The server process is removed from the server group and the Server Group List 
page is refreshed.

See Also
� Section 5.6.7.2, "Removing a Server Process from an Interaction Center Server 

Manager Node"

5.6.7.2 Removing a Server Process from an Interaction Center Server Manager 
Node
Use this procedure to remove an interaction center server from a machine. The 
server process remains in the server group without an assigned node.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Stop the server process if it is running.

Steps
1. Select the ICSM tab.

2. Click Nodes.

The Node List page appears. 

3. Click a node name.

The Node Details page appears.

4. Select the Remove checkbox for the server process that you want to remove.
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5. Click Update.

The server is removed from the node and the Node Details page is refreshed.

See Also
� Section 5.6.7.1, "Removing a Server Process from an Interaction Center Server 

Group"

5.6.8 Removing an Interaction Center Server Group
Use this procedure to remove an interaction center server group.

Login
Self-Service Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Stop any server processes that are running in the server group.

Steps
1. Select the ICSM tab.

2. Click Server Groups.

The Server Group List page appears. 

3. Select the Remove checkbox for the server group that you want to remove.

4. Click Update.

The server group is removed and the Server Group List page is refreshed.

See Also
� Section 5.6.1, "Viewing the Status of a Server Process"

� Section 5.6.2, "Adding a Server Process to an Interaction Center Server Group"

� Section 5.6.3, "Moving a Server Process to a Different Node"

� Section 5.6.4, "Configuring Interaction Center Server Process Parameters"

� Section 5.6.5, "Starting Server Processes"
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� Section 5.6.6, "Stopping Server Processes"

� Section 5.6.7, "Removing a Server Process"

5.7 Creating an Interaction Center Agent
Perform the steps in the following table to define an interaction center agent. The 
Number column indicates the step order. The Required column indicates whether a 
step is required. The Description column describes a high-level step and, where 
applicable, provides a reference to a more detailed topic in this document. The 
Responsibility column indicates the Oracle Applications user account responsibility 
required to complete the step.

If you have defined an administrator for an Oracle interaction center, then that user 
has all of the responsibilities necessary to create an interaction center agent.

Number Required? Description Responsibility

❏ Step 1 Required Create an employee.

If Oracle Human Resource Management Systems is 
installed, see Section 5.7.1, "Creating an Employee in 
Oracle Human Resource Management Systems".

If Oracle Human Resource Management Systems is not 
installed, see Section 5.7.2, "Creating an Employee in 
CRM Resource Manager".

HRMS Manager for 
Oracle Human Resource 
Management Systems

OR

CRM Resource Manager 
for CRM Resource 
Manager

❏ Step 2 Required Create an Oracle Applications user account for the 
employee.

See Section 5.7.3, "Creating an Oracle Applications User 
Account for an Employee".

System Administration

❏ Step 3 Required Configure system profile options.

See: Section 5.7.4, "Configuring Profile Options"

System Administrator

❏ Step 4 Required Create a CRM resource for the employee.

See Section 5.7.5, "Creating a CRM Resource for an 
Employee".

CRM Resource Manager

❏ Step 5 Required Configure resource roles for the CRM resource.

See: Section 5.7.6.1, "Configuring Resource Roles for an 
Agent"

CRM Resource Manager
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See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"

� Section 5.7, "Creating an Interaction Center Agent"

5.7.1 Creating an Employee in Oracle Human Resource Management Systems

Use this procedure to create an employee in Oracle Human Resource Management 
Systems (HRMS).

Login
Self-Service Login URL

Responsibility
HRMS Manager (for example, US HRMS Manager)

❏ Step 6 TeleSales 
only

Configure group member roles and usage for the CRM 
resource.

See: Section 5.7.6.2, "Configuring Group Member Roles 
and Usage for an Agent"

CRM Resource Manager

❏ Step 7 Telephony 
only

Configure interaction center parameters for the CRM 
resource.

See: Section 5.7.7, "Configuring Interaction Center 
Parameters for a CRM Resource"

CRM Resource Manager

Note: If you do not have Oracle Human Resource Management 
Systems installed, then see Section 5.7.2, "Creating an Employee in 
CRM Resource Manager".

Number Required? Description Responsibility
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Prerequisites
� Review Managing People Using Oracle HRMS.

Steps
1. In the Navigator window, on the Functions tab, choose People > Enter and 

Maintain.

The Find Person window appears.

2. Click New.

The People window appears.

3. Enter the information for the new person.

The following fields are required:

� Last (Name)

� Gender

� Type

� Employee (Number)

Other fields may be required depending on how your enterprise has set up 
Oracle HRMS. In addition, when you save the record, you may receive one or 
more messages that explain the consequences of leaving certain fields blank.

4. From the File menu, choose Save.

You may close the People window.

See Also
� Section 5.7.2, "Creating an Employee in CRM Resource Manager"

� Section 5.7.3, "Creating an Oracle Applications User Account for an Employee"

Note: In the Type field, select Employee.

Note: If the Employee field is inactive, then Oracle HRMS is set 
up to automatically generate the employee number when the 
record is saved.
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� Section 5.7.4, "Configuring Profile Options"

� Section 5.7.5, "Creating a CRM Resource for an Employee"

� Section 5.7.6, "Configuring CRM Roles and Usage for an Agent"

� Section 5.7.7, "Configuring Interaction Center Parameters for a CRM Resource"

5.7.2 Creating an Employee in CRM Resource Manager

Use this procedure to create an employee when Oracle Human Resources 
Management Systems (HRMS) is not installed. This procedure populates the same 
database tables as the People window in Oracle Human Resource Management 
Systems.

Login
Self-Service Login URL

Responsibility
CRM Resource Manager

Prerequisites
� Review Oracle Foundation Concepts and Procedures.

Steps
1. In the Navigator window, on the Functions tab, choose Maintain Employee > 

Employee.

The Find Person window appears.

2. Click New.

The People window appears.

3. Enter the information for the new person.

The following fields are required:

Note: If Oracle Human Resource Management Systems is 
installed, then see Section 5.7.1, "Creating an Employee in Oracle 
Human Resource Management Systems".
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� Last (Name)

� Gender

� Type

� Employee (Number)

Other fields may be required depending on how your enterprise has set up 
Oracle CRM Resource Manager. In addition, when you save the record, you 
may receive one or more messages that explain the consequences of leaving 
certain fields blank.

4. From the File menu, choose Save.

You may close the People window.

See Also
� Section 5.7.1, "Creating an Employee in Oracle Human Resource Management 

Systems"

� Section 5.7.3, "Creating an Oracle Applications User Account for an Employee"

� Section 5.7.4, "Configuring Profile Options"

� Section 5.7.5, "Creating a CRM Resource for an Employee"

� Section 5.7.6, "Configuring CRM Roles and Usage for an Agent"

� Section 5.7.7, "Configuring Interaction Center Parameters for a CRM Resource"

5.7.3 Creating an Oracle Applications User Account for an Employee
Use this procedure to create an Oracle Applications user and to associate an 
employee (created in Oracle Human Resource Management Systems or CRM 
Resource Manager) with a user account.

Note: In the Type field, select Employee.

Note: If the Employee field is inactive, then Oracle CRM Resource 
Manager is setup to automatically generate the employee number 
when the record is saved.
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Login
Self-Service Login URL

Responsibility
System Administrator

Prerequisites
� Review Oracle Applications Systems Administrator’s Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Security > User > 

Define.

The Users window appears.

Use the following guidelines to define Oracle Applications usernames:

� Use only alphanumeric characters (’A’ through ’Z’, and ’0’ through ’9’), 
underscore, space, or hyphen.

� Use only the set of characters that your operating system supports for 
filenames.

2. In the User Name field, enter the name of the user.

The password is temporary. When the user signs on to Oracle Applications for 
the first time, the message "Your password has expired" appears and the user is 
prompted to set a new password.

Use the following guidelines to define Oracle Applications passwords:

� Use at least five characters and no more than 100 characters.

� Use only alphanumeric characters (’A’ through ’Z’, and ’0’ through ’9’), 
underscore, space, or hyphen.

3. In the Password field, enter the password for the user account and then press 
Tab.

The cursor remains in the Password field.

4. Enter the password again and then press Tab to verify the password.

5. In the Person field, select an employee to associate with this user account.

6. In the Responsibilities tab, add responsibilities.
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Once the user record has been saved, you cannot delete an assigned 
responsibility. Oracle Applications maintains audit data for assigned 
responsibilities.

To deactivate an assigned responsibility, set the effective end date (in the 
Effective Dates - To field) of the assigned responsibility to the current date. To 
activate an assigned responsibility, clear or reset the effective end date.

7. From the File menu, choose Save.

You may close the Users window.

See Also
� Section 5.7.1, "Creating an Employee in Oracle Human Resource Management 

Systems"

� Section 5.7.2, "Creating an Employee in CRM Resource Manager"

� Section 5.7.4, "Configuring Profile Options"

� Section 5.7.5, "Creating a CRM Resource for an Employee"

� Section 5.7.6, "Configuring CRM Roles and Usage for an Agent"

� Section 5.7.7, "Configuring Interaction Center Parameters for a CRM Resource"

5.7.4 Configuring Profile Options
Use this procedure to set Oracle Interaction Center profile options for application 
work.

Login
Self-Service Login URL

Responsibility
System Administrator

Prerequisites
� Review Oracle Applications Systems Administrator’s Guide.

� For a list of profile options, review the "Profile Options" appendix in the 
product implementation guide.
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Steps
1. In the Navigator window, on the Functions tab, choose Profile > System.

The Find System Profile Values window appears. The Site and Profiles with No 
Values checkboxes are selected by default.

2. Specify the level or levels at which you wish to view or set profile option 
values.

Typically, interaction center profile options are set for the Oracle Applications 
instance (for the purpose of profile options, this is also called the site). Then, if 
necessary, the profile options are modified for a user or a set of users working 
under a responsibility.

� If you want to view or set profile options for all users at the installation site, 
select the Site box.

� If you want to view or set profile options for users working under 
responsibilities owned by a specific application, select the Application box 
and then select an application from the Application list.

� If you want to view or set profile options for users working under a specific 
responsibility, select the Responsibility box and then select a responsibility 
from the Responsibility list.

� If you want to view or set profile options for a specific user, select the User 
box and then select a username from the User list.

3. If you want to display profile options both with and without values, select the 
Profiles with No Values checkbox.

4. If you want to display profile options that include a specific character string, 
enter the string in the Profile field.

You may search for profile options using character strings and the wildcard 
symbol (%). For example, to find profile options prefixed by "IEU", the product 
code for Oracle Universal Work Queue, enter IEU%.

5. Click Find.

The System Profile Values window appears.

6. Set the values for the profile options at one or more levels.

When a profile option may be set at more than one level, the value entered at 
the Site level has the lowest priority. The value entered at the Site level is 
superseded by any value entered at the Application level value and the value 
entered at the Application level is superseded by any value entered at the 
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Responsibility level. The value entered at the User level has the highest priority 
and overrides values entered at any other level. 

7. From the File menu, choose Save.

Your changes take effect as soon as users sign on or change responsibility. You 
may close the System Profile Values window.

See Also
� Section 5.7.1, "Creating an Employee in Oracle Human Resource Management 

Systems"

� Section 5.7.2, "Creating an Employee in CRM Resource Manager"

� Section 5.7.3, "Creating an Oracle Applications User Account for an Employee"

� Section 5.7.5, "Creating a CRM Resource for an Employee"

� Section 5.7.6, "Configuring CRM Roles and Usage for an Agent"

� Section 5.7.7, "Configuring Interaction Center Parameters for a CRM Resource"

5.7.5 Creating a CRM Resource for an Employee
Use this procedure to create a Customer Relationship Management (CRM) resource 
for an employee (created in Oracle Human Resource Management Systems or CRM 
Resource Manager).

Login
Self-Service Login URL

Responsibility
CRM Resource Manager

Prerequisites
� Review Oracle CRM Foundation Concepts and Procedures.

Steps
1. In the Navigator window, on the Functions tab, choose Maintain Resources > 

Import Resources.

The Selection Criteria window appears.

2. In the Resource Category field, select Employee.
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3. Enter any additional selection criteria.

For example, in the Name field, select the name of an employee.

4. Click Search.

Employees that meet the search criteria are listed in the Search Results area. The 
Select checkboxes for the matching employees are automatically selected.

5. Clear the Select checkboxes of the employees for whom you do not want to 
create a CRM resource.

6. Click Create Resource.

The Default Values window appears. You can add or modify this information in 
the resource details later. 

7. Click OK to accept the defaults.

The Selected Resources window appears. The Comments field indicates 
whether the resource is a new record, a duplicate record, or a duplicate record 
with a new role definition. The Select checkboxes are automatically selected.

8. Clear the Select checkboxes of the emplyees that you do not want to save as a 
resource.

9. To save the resources, click Save Resource.

A transaction number appears in the Transaction Number field. The transaction 
number is associated with each resource created during this transaction. More 
than one resource can have the same transaction number.

10. To view the details about a resource, select the resource and then click Details.

The Resource window appears. Verify the name of the resource (Name), the 
name of the employee (Source Name), and the user name (User Name) and note 
the resource number (Number).

You may close the Resources, Selected Resources, Default Values, and Selection 
Criteria windows.

See Also
� Section 5.7.1, "Creating an Employee in Oracle Human Resource Management 

Systems"

� Section 5.7.2, "Creating an Employee in CRM Resource Manager"

� Section 5.7.3, "Creating an Oracle Applications User Account for an Employee"
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� Section 5.7.4, "Configuring Profile Options"

� Section 5.7.6, "Configuring CRM Roles and Usage for an Agent"

� Section 5.7.7, "Configuring Interaction Center Parameters for a CRM Resource"

5.7.6 Configuring CRM Roles and Usage for an Agent
Use this procedure to configure the CRM resource parameters for a resource using 
Oracle Interaction Center to access Oracle TeleSales.

Topics include:

� Section 5.7.6.1, "Configuring Resource Roles for an Agent"

� Section 5.7.6.2, "Configuring Group Member Roles and Usage for an Agent"

See Also
� Section 5.7.1, "Creating an Employee in Oracle Human Resource Management 

Systems"

� Section 5.7.2, "Creating an Employee in CRM Resource Manager"

� Section 5.7.3, "Creating an Oracle Applications User Account for an Employee"

� Section 5.7.4, "Configuring Profile Options"

� Section 5.7.5, "Creating a CRM Resource for an Employee"

� Section 5.7.7, "Configuring Interaction Center Parameters for a CRM Resource"

5.7.6.1 Configuring Resource Roles for an Agent
Use this procedure to configure the CRM resource roles for an Oracle TeleSales user.

Login
Self-Service Login URL

Responsibility
CRM Resource Manager

Prerequisites
� Create an employee.

� Create an Oracle Applications user account for the employee.
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� Create a CRM resource for the employee.

� Review Oracle CRM Foundation Concepts and Procedures.

� Review Oracle TeleSales Implementation Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Resource Manager > 

Maintain Resources > Resources.

The Find Resources window appears.

2. Enter any selection criteria.

For example, in the Name field, select the name of an employee.

3. Click Find.

The Research Search Results window appears.

4. Select the resource and then click Resource Details.

The Resource window appears, populated with information regarding the 
selected resource.

5. In the Roles tab, assign one or more roles to the resource.

a. In the Role Type field, select a role type.

The following table lists the minimum role types required to access 
application or media work in Oracle Universal Work Queue. Additional 
role types may be required to enable additional functionality in the business 
application. For more information, consult the implementation guide for 
the business application.

b. In the Role field, select a role.

6. From the File menu, choose Save.

You may close the Resource and Research Search Results windows.

To use this application or feature... Select this role type...

Oracle TeleSales Telesales

Oracle TeleService No role type requirement.

Oracle Advanced Inbound, Oracle Advanced Outbound Callcenter
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See Also
� Section 5.7.6.2, "Configuring Group Member Roles and Usage for an Agent"

5.7.6.2 Configuring Group Member Roles and Usage for an Agent
Use this procedure to configure CRM group roles and usage for a agent.

Login
Self-Service Login URL

Responsibility
CRM Resource Manager

Prerequisites
� Create an employee.

� Create an Oracle Applications user account for the employee.

� Create a CRM resource for the employee.

� Review Oracle CRM Foundation Implementation Guide.

� Review Oracle TeleSales Implementation Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Resource Manager > 

Maintain Resources > Groups.

The Define Groups window appears.

2. Find a group or create a group by entering a group name.

3. In the Members tab, add a resource to the group.

a. In the Category field, enter Employee.

b. In the Number field, enter the resource number or, in the Name field, enter 
the name of the resource.

c. Click Member Roles.

The Member Roles window appears.

d. In the Role Type field, select a role type.
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The following table lists the minimum role types required to access 
application or media work in Oracle Universal Work Queue. Additional 
role types may be required to enable additional functionality in the business 
application. For more information, consult the implementation guide for 
the business application.

e. In the Role field, select a role.

f. Click OK.

4. In the Usages tab, enter one or more usages for the group.

The following table lists the minimum usages required to access application 
or media work in Oracle Universal Work Queue. Additional usages may be 
required to enable additional functionality in the business application. For 
more information, consult the implementation guide for the business 
application.

5. From the File menu, choose Save.

You may close the Define Groups window.

Note: Only the roles assigned to the resource in the Resource 
window Roles tab will be available for selection in the Member 
Roles window for a group member.

To use this application or feature... Select this role type...

Oracle TeleSales Telesales

Oracle TeleService No role type requirement.

Oracle Advanced Inbound, Oracle Advanced Outbound Callcenter

To use this application or feature... Select this usage...

Oracle TeleSales Sales and TeleSales

Oracle TeleService No usage requirement.

Oracle Advanced Inbound, Oracle Advanced Outbound Call Center
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See Also
� Section 5.7.6.1, "Configuring Resource Roles for an Agent"

5.7.7 Configuring Interaction Center Parameters for a CRM Resource

Use this procedure to configure the interaction center parameters for a CRM 
(Customer Relationship Management) resource. Use the Interaction Center tab in 
the Resource window to specify the following information for the CRM resource:

� Interaction center server group

� Telephony parameters

Login
Self-Service Login URL

Responsibility
CRM Resource Manager

Prerequisites
� Create an employee.

� Create an Oracle Applications user account for the employee.

� Create a CRM resource for the employee.

� Create a middleware definition. Review Oracle Advanced Inbound Implementation 
Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Maintain Resources > 

Resources.

The Find Resources window appears.

2. Enter any selection criteria.

For example, in the Name field, select the name of an employee.

3. Click Find.

Note: This procedure applies to media work only.
5-68 Oracle Applications Interaction Center Implementation Guide



Creating an Interaction Center Agent
The Resource Search Results window appears.

4. Select a resource and then click Resource Details.

The Resource window appears.

5. In the Interaction Center tab, specify the interaction center parameters.

a. In the Interaction Center field, select the interaction center server group for 
the resource.

b. For inbound and outbound telephony, in the Telephony Parameters area, 
enter the telephony parameters for the agent.

* In the Middleware field, select the middleware configuration that the 
selected interaction center server group uses to communicate with the 
switch and middleware.

* In the Parameter field, select a parameter name.

* In the Value field, enter a value for the parameter.

The telephony parameters required for a resource depend on the type 
of switch and middleware used in the interaction center.

Aspect CallCenter v.8.0.2 SP01 with Cisco ICM
If you are using an Aspect CallCenter v.8.0.2 SP01 switch with Cisco ICM 
middleware, then use the following table to set the telephony parameters 
for the agent.

Avaya Definity v9 (via EAS) with Cisco ICM
If you are using an Avaya Definity v9 (via EAS) switch with Cisco ICM 
middleware, then use the following table to set the telephony parameters 
for the agent.

Parameter Description Example

ACD Data 1 Agent’s ACD password, as defined in the PBX admin. 1001

ACD Data 2 Agent’s ACD login ID, as defined in the PBX admin. 1001

ACD Queue Agent’s skill group number, as defined in the PBX 
admin.

46

Parameter Description Example
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Avaya Definity v9 (via EAS) with Intel CT Connect
If you are using an Avaya Definity v9 (via EAS) switch with Intel CT 
Connect middleware, then use the following table to set the telephony 
parameters for the agent.

Nortel Meridian r25 (via Meridian Link Services v4) with Cisco ICM
If you are using a Nortel Meridian r25 (w/ Meridian Link Services v4) 
switch with Cisco ICM middleware, then use the following table to set the 
telephony parameters for the agent.

Nortel Meridian r25 (via Meridian Link Services v4) with Intel CT Connect
If you are using a Nortel Meridian r25 (w/ Meridian Link Services v4) with 
Intel CT Connect middleware, then use the following table to set the 
telephony parameters for the agent.

6. From the File menu, choose Save.

ACD Data 1 Agent’s ACD password, as defined in the PBX admin. 34181

ACD Data 2 Agent’s ACD login ID, as defined in the PBX admin. 34181

ACD Queue Agent’s skill group number, as defined in the Cisco ICM 
configuration

46

Parameter Description Example

ACD Data 1 Agent’s ACD password, if any, as defined in the PBX 
admin.

34181

ACD Data 2 Agent’s ACD login ID, as defined in the PBX admin. 34181

Parameter Description Example

ACD Data 2 The Agent Peripheral Number defining in the Cisco ICM 
configuration.

8701

Parameter Description Example

ACD Data 1 (Required only when the switch is in login ID mode) 
Agent’s ACD login ID, as defined in the PBX admin.

1001
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See Also
� Section 5.1, "Defining an Administrator for Oracle Interaction Center"

� Section 5.2, "Implementing an Interaction Center Server Manager Node"

� Section 5.3, "Administering an Interaction Center Server Manager Node"

� Section 5.4, "Implementing a Single-Site Interaction Center"

� Section 5.5, "Implementing a Multi-Site Interaction Center"

� Section 5.6, "Administering an Interaction Center"
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Verifying the Implementation

Topics include:

� Section 6.1, "Oracle Interaction Center Implementation Verification Tasks"

� Section 6.2, "Implementing the Web Phone for Inbound Call to the Switch 
Simulator"

� Section 6.3, "Testing Advanced Inbound Using the Switch Simulator"

6.1 Oracle Interaction Center Implementation Verification Tasks
Perform the steps in the following table to verfiy the implemention of Oracle 
Interaction Center. The Number column indicates the step order. The Required 
column indicates whether a step is required. The Description column describes a 
high-level step and, where applicable, provides a reference to a more detailed topic 
in this document. The Responsibility column indicates the Oracle Applications user 
account responsibility required to complete the step.

If you have defined an administrator for Oracle Interaction Center media work, 
then that user will have all of the responsibilities necessary to implement Oracle 
Interaction Center.

Number Required? Description Responsibility

❏ Step 1 Required Create a server group.

See: Section 5.4.1, "Creating a Single-Site Interaction 
Center"

Call Center HTML 
Administration

❏ Step 2 Required Create a middleware configuration.

See: Section 6.1.1, "Creating a Middleware Defintion for 
Use with the Switch Simulator"

Call Center HTML 
Administration
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See Also
� Section 6.2, "Implementing the Web Phone for Inbound Call to the Switch 

Simulator"

� Section 6.3, "Testing Advanced Inbound Using the Switch Simulator"

6.1.1 Creating a Middleware Defintion for Use with the Switch Simulator
Use this procedure to define a middleware configuration to be used with the switch 
simulator. The switch simulator simulates a Nortel Meridian switch. Using this 
configuration with the switch simulator, you can verify interaction center 

❏ Step 3 Required Configure the parameters for the interaction center 
servers.

See: Section 6.1.2, "Configuring the Interaction Center 
Server Process Parameters for Use with the Switch 
Simulator"

Call Center HTML 
Administration

❏ Step 4 Required Create teleset configurations.

See: Section 6.1.3, "Creating Teleset Configurations"

Call Center HTML 
Administration

❏ Step 5 Required Configure Oracle Universal Work Queue to produce a 
application screen pop for media work.

See: Section 6.1.4, "Configuring a Media Screen Pop for 
Oracle Interaction Center"

Call Center HTML 
Administration

❏ Step 6 Required Create a web phone use for simulating a customer call to 
the switch simulator.

See: Section 6.2.1, "Creating Web Phone User Account"

CCT_WEBPHONE_
DEMO_RESP

❏ Step 7 Required Configure the system profile options for the web phone.

See: Section 6.2.2, "Configuring the Web Phone Profile 
Options for the Web Phone User"

System Administrator

❏ Step 8 Required Configure the system profile options for media work in 
Oracle Interaction Center.

See Section 6.1.5, "Configuring Profile Options for Media 
Work".

System Administrator

❏ Step 9 Required Start the servers in the interaction center server group.

See: Section 5.2.4, "Starting the Interaction Center Server 
Manager Node"

Call Center HTML 
Administration

Number Required? Description Responsibility
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application configuration without concern for switch-specific functionality. This can 
help validate implementations by abstracting issues with switch setup.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Implement Oracle Call Center Connectors

Steps
1. Click the Call Center tab.

2. Click Middleware.

The Middleware Details page displays.

3. In the Choose Server Group field, select a server group.

4. Click Create.

5. Enter the information for the middleware defintion.

6. Click Update.

The Teleset Details, Route Point Details, and Middleware Parameters areas 
appear.

Field Value Example

Middleware Name The name of the middleware 
configuration defined for use 
with the Switch Simulator server.

servergroup_mw

IP Address The IP address of the Interaction 
Center Server Manager node to 
which the Switch Simulator 
server is assigned.

123.4.5.67

Port The listener port fo the Switch 
Simulator server.

3201

Middleware Type Connectors for CT-Connect NA
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7. In the Parameters area, enter the following values:

8. Click Update.

See Also
� Section 6.1.2, "Configuring the Interaction Center Server Process Parameters for 

Use with the Switch Simulator"

� Section 6.1.3, "Creating Teleset Configurations"

� Section 6.1.4, "Configuring a Media Screen Pop for Oracle Interaction Center"

� Section 6.1.5, "Configuring Profile Options for Media Work"

6.1.2 Configuring the Interaction Center Server Process Parameters for Use with the 
Switch Simulator

Use this procedure to configure the parameters for a server in an Oracle interaction 
center server group.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Create a server group.

Steps
1. Select the ICSM tab.

Parameter Value Example

PBX Name nortel NA

PBX Type Nortel Meridan NA

CTI Enabler Server IP Address <IP address of the ICSM node 
for the Switch Simulator>

123.4.5.67

Middleware Server Info 1 ncan_ip_tcp NA
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2. Click Server Groups.

The Server Group List page appears.

3. Click the server group name.

The Server Group Details page displays.

4. In the Servers area, click the Inbound Telephony Server name.

The Server Details - General page appears for the specified server.

5. Click Parameters.

The Server Details - Parameters page appears.

6. In the Parameter Value field for TELE_MIDDLEWARE_CONFIG, enter the 
name of your middleware configuration.

7. Click Update.

8. Click Server Groups.

The Server Group List page appears.

9. Click the server group name.

10. In the Servers area, click the Switch Simulator server name.

The Server Details - General page appears.

11. Click Parameters.

The Server Details - Parameters page appears.

12. Enter the parameters for the switch simulator.

The switch simulator simulates a Nortel Meridian switch. Each Nortel teleset 

Parameter Value

EXTENSION_RANGE_1_BEGIN Enter the start range for the line 1 agent extensions.

EXTENSION_RANGE_1_END Enter the end range for the line 1 agent extensions.

EXTENSION_RANGE_2_BEGIN Enter the start range for the line 2 agent extensions.

EXTENSION_RANGE_2_END Enter the end range for the line 2 agent extensions.

EXTENSION_RANGE_3_BEGIN Enter the start range for extensions for the web phone.

EXTENSION_RANGE_3_END Enter the end range for extensions for the web phone.

ROUTE_POINT_1 Enter a route point.
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13. Click Update.

See Also
� Section 6.1.1, "Creating a Middleware Defintion for Use with the Switch 

Simulator"

� Section 6.1.3, "Creating Teleset Configurations"

� Section 6.1.4, "Configuring a Media Screen Pop for Oracle Interaction Center"

� Section 6.1.5, "Configuring Profile Options for Media Work"

6.1.3 Creating Teleset Configurations
Use this procedure to configure telesets for the switch simulator.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
� Implement Oracle Call Center Connectors

Steps
1. Click the Call Center tab.

2. Click Teleset.

3. In the Choose Server Group field, select a server group.

4. In the Choose Middleware field, select a server group.

ROUTE_POINT_2 Enter a route point.

ROUTE_POINT_3 Enter a route point

TELE_MIDDLEWARE_CONFIG The name of the middleware configuration.

TRACE_LEVEL Enter None.

Parameter Value
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5. Click Create.

6. Enter the information for the teleset configuration

a. In the Teleset Name field, enter the name of the teleset configuration.

b. In the Hardware Number field, enter a number to identify the teleset 
hardware.

c. In the Teleset Type field, select Nortel.

d. In the Server Group Name field, select the server group.

e. In the Middleware Name field, select the middleware configuration.

f. Click Create.

The Lines section appears.

7. In the Extension field for Line Index 1, enter a line from the switch simulator 
parameter values for EXTENSION_RANGE_1.

8. In the Extension field for Line Index 2, enter a line from the switch simulator 
parameter values for EXTENSION_RANGE_2.

9. Click Update.

10. To add another teleset, repeat step2 through step 9.

See Also
� Section 6.1.1, "Creating a Middleware Defintion for Use with the Switch 

Simulator"

� Section 6.1.2, "Configuring the Interaction Center Server Process Parameters for 
Use with the Switch Simulator"

� Section 6.1.4, "Configuring a Media Screen Pop for Oracle Interaction Center"

� Section 6.1.5, "Configuring Profile Options for Media Work"

6.1.4 Configuring a Media Screen Pop for Oracle Interaction Center
Classifications (for example, "Gold Support") can be assigned to calls based on the 
information in the call (for example, the number dialed by the caller). Then, for a 
specific type of media, the classification is mapped to an application window. When 
an agent requests delivery of that media type, the mapped business application is 
launched.
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Use this procedure to associate media work with a CRM business application. 
When a media item is delivered to the Oracle Interaction Center desktop, a CRM 
business application is launched based on the media type and the media item 
classification.

Login
HTML Login URL

Responsibility
Call Center HTML Administration

Prerequisites
None

Steps
1. Select the Media Actions tab.

The Media Classification Action Association page appears.

2. In the Media Type field, select Inbound Telephony.

3. Leave the Classification field blank.

4. In the Media Action field, select the Customer Care media function or 
TeleSales Inbound Telephony function.

This determines the application that will be launched when a media item of the 
specified type with the specified classification is selected from a work node.

5. To clear a row, select the Remove checkbox to the left of the media classification 
action association. Selected rows will be removed when you click Update.

6. To save your work, click Update.

The Media Classification Action Association page appears.

7. To delete a media classification action association, select the Remove checkbox 
to the left of the media type and click Update.

Note: The call classification triggers the media action (screen pop). 
A blank field in the Classification column is used to indicate the 
default media action for an unclassified media item.
6-8 Oracle Applications Interaction Center Implementation Guide



Oracle Interaction Center Implementation Verification Tasks
See Also
� Section 6.1.1, "Creating a Middleware Defintion for Use with the Switch 

Simulator"

� Section 6.1.2, "Configuring the Interaction Center Server Process Parameters for 
Use with the Switch Simulator"

� Section 6.1.3, "Creating Teleset Configurations"

� Section 6.1.5, "Configuring Profile Options for Media Work"

6.1.5 Configuring Profile Options for Media Work
Use this procedure to set system profile options.

Login
Self Service Login URL

Responsibility
System Administrator

Prerequisites
� Review Oracle Applications Systems Administrator’s Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Profile > System.

The Find System Profile Values window appears. The Site and Profiles with No 
Values checkboxes are selected by default.

2. Specify the level or levels at which you wish to view or set profile option 
values.

� If you want to view or set profile options for all users at the installation site, 
select the Site box.

� If you want to view or set profile options for users working under 
responsibilities owned by a specific application, select the Application box 
and then select an application from the Application list.

� If you want to view or set profile options for users working under a specific 
responsibility, select the Responsibility box and then select a responsibility 
from the Responsibility list.
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� If you want to view or set profile options for a specific user, select the User 
box and then select a username from the User list.

3. If you want to display profile options both with and without values, select the 
Profiles with No Values checkbox.

4. If you want to display profile options that include a specific character string, 
enter the string in the Profile field.

You may search for profile options using character strings and the wildcard 
symbol (%). For example, to find profile options prefixed by "IEU", the product 
code for Oracle Universal Work Queue, enter IEU%.

5. Click Find.

The System Profile Values window appears.

6. Set the values for the profile options at one or more levels.

When a profile option may be set at more than one level, the value entered at 
the Site level has the lowest priority. The value entered at the Site level is 
superseded by any value entered at the Application level value and the value 
entered at the Application level is superseded by any value entered at the 
Responsibility level. The value entered at the User level has the highest priority 
and overrides values entered at any other level. 

The following table lists the Oracle Interaction Center profile option values to 
be used for testing Oracle Interaction Center with media work.

Profile Option Value

IEU: Blending Style Not Blended

IEU: Desktop: Network: Proxy Port Null

IEU: Desktop: Network: Proxy Server Null

IEU: Desktop: Network: Use Proxy No

IEU: Desktop: Trace Level None

IEU: Desktop: UI: Refresh Style Automatic

IEU: Desktop: UI: Show All Nodes Yes

IEU: Desktop: UI: Refresh Rate Null

IEU: Message: UI: UWQ Notice No

IEU: Optional: Phone Extension Null
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7. From the File menu, choose Save.

IEU: Queue Order: Advanced Outbound 
Telephony

Null

IEU: Queue Order: Blended Null

IEU: Queue Order: Enterprise Tasks Null

IEU: Queue Order: Escalations Null

IEU: Queue Order: Forecasts Null

IEU: Queue Order: Inbound Email Null

IEU: Queue Order: Inbound Telephony Null

IEU: Queue Order: Leads Null

IEU: Queue Order: Media Nodes Null

IEU: Queue Order: Opportunities Null

IEU: Queue Order: Outbound Telephony Null

IEU: Queue Order: Service Requests Null

IEU: Queue Order: Work List Null

IEU: Queue: Advanced Outbound 
Telephony

Null

IEU: Queue Enterprise Tasks Yes

IEU: Queue: Escalations Yes

IEU: Queue: Forecasts Yes

IEU: Queue: Inbound Email No

IEU: Queue: Inbound Telephony Yes

IEU: Queue: Leads Yes

IEU: Queue: Opportunities Yes

IEU: Queue: Outbound Telephony No

IEU: Queue: Service Requests Yes

IEU: Queue: Work List Yes

IEU: Session History Logging No

Profile Option Value
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Your changes take effect as soon as users sign on or change responsibility.

See Also
� Section 6.1.1, "Creating a Middleware Defintion for Use with the Switch 

Simulator"

� Section 6.1.2, "Configuring the Interaction Center Server Process Parameters for 
Use with the Switch Simulator"

� Section 6.1.3, "Creating Teleset Configurations"

� Section 6.1.4, "Configuring a Media Screen Pop for Oracle Interaction Center"

6.2 Implementing the Web Phone for Inbound Call to the Switch 
Simulator

Topics include:

� Section 6.2.1, "Creating Web Phone User Account"

� Section 6.2.2, "Configuring the Web Phone Profile Options for the Web Phone 
User"

See Also
� Section 6.1, "Oracle Interaction Center Implementation Verification Tasks"

� Section 6.3, "Testing Advanced Inbound Using the Switch Simulator"

6.2.1 Creating Web Phone User Account
Use this procedure to create an Oracle Applications user account for operating the 
web phone.

Login
Self Service Login URL

Responsibility
System Administrator

Prerequisites
� Review Oracle Applications Systems Administrator’s Guide.
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Steps
1. In the Navigator window, on the Functions tab, choose Security > User > 

Define.

The Users window appears.

Use the following guidelines to define Oracle Applications usernames:

� Use only alphanumeric characters (’A’ through ’Z’, and ’0’ through ’9’), 
underscore, space, or hyphen.

� Use only the set of characters that your operating system supports for 
filenames.

2. In the User Name field, enter the name of the user account.

The password is temporary. When the user signs on to Oracle Applications for 
the first time, the message "Your password has expired" appears and the user is 
prompted to set a new password.

Use the following guidelines to define Oracle Applications passwords:

� Use at least five characters and no more than 100 characters.

� Use only alphanumeric characters (’A’ through ’Z’, and ’0’ through ’9’), 
underscore, space, or hyphen.

3. In the Password field, enter the password for the user account and then press 
Tab.

The cursor remains in the Password field.

4. Enter the password again to verify it.

5. In the Person field, select an employee to associate with this user account.

6. In the Responsibilities tab, add the following responsibility:

Once the user record has been saved, you cannot delete an assigned 
responsibility. Oracle Applications maintains audit data for assigned 
responsibilities.

Responsibility Function Type

CCT_WEBPHONE_DEMO_RESP Operate the Web phone to simulate a customer call to 
the Switch Simulator

HTML
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To deactivate an assigned responsibility, set the effective end date (in the 
Effective Dates - To field) of the assigned responsibility to the current date. To 
activate an assigned responsibility, clear or reset the effective end date.

7. From the File menu, choose Save.

See Also
� Section 6.2.2, "Configuring the Web Phone Profile Options for the Web Phone 

User"

6.2.2 Configuring the Web Phone Profile Options for the Web Phone User
Use this procedure to set system profile options for the web phone user.

Login
Self Service Login URL

Responsibility
System Administrator

Prerequisites
� Review Oracle Applications Systems Administrator’s Guide.

Steps
1. In the Navigator window, on the Functions tab, choose Profile > System.

The Find System Profile Values window appears. The Site and Profiles with No 
Values checkboxes are selected by default.

2. Select the User box and then enter the name of the web phone user.

3. If you want to display profile options both with and without values, select the 
Profiles with No Values checkbox.

4. If you want to display profile options that include a specific character string, 
enter the string in the Profile field.

You may search for profile options using character strings and the wildcard 
symbol (%). For example, to find web phone profile options, enter 
CCT:TOOL%.

5. Click Find.
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The System Profile Values window appears.

6. Set the values for the profile options at one or more levels.

When a profile option may be set at more than one level, the value entered at 
the Site level has the lowest priority. The value entered at the Site level is 
superseded by any value entered at the Application level value and the value 
entered at the Application level is superseded by any value entered at the 
Responsibility level. The value entered at the User level has the highest priority 
and overrides values entered at any other level. 

The following table lists the Oracle Interaction Center profile option values to 
be used for testing Oracle Interaction Center with media work.

Profile Option Value Example

CCT:TOOL:SERVER_GROUP <servergroupname> servergroup

CCT:TOOL:MW_CONFIG <middlewareconfigurationname> servergroup_mw

CCT:TOOL:EXT_START Enter the EXTENSTION_RANGE_3_
START value from the Switch Simulator 
configuration.

9001

CCT:TOOL:EXT_END Enter the EXTENSION_RANGE_3_END 
value from the Switch Simulator 
configuration.

9005

CCT:TOOL:DEFAULT_ROUTE_
POINT 

Enter a route point. 7720

CCT:TOOL:REFRESH_RATE This is the refresh rate of the web phone 
interface in seconds. The default is 5.

5

CCT:TOOL:HIDDEN_DATA Do not use.

The default is No. This profile option is 
for hidden data passed in the inbound 
call. It has the format 
key1=value1,key2=value2.

NA

CCT:TOOL:VISIBLE_ROUTE_
POINT

Do not use. NA
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7. From the File menu, choose Save.

Your changes take effect as soon as users sign on or change responsibility.

See Also
� Section 6.2.1, "Creating Web Phone User Account"

6.3 Testing Advanced Inbound Using the Switch Simulator
Topics include:

� Section 6.3.1, "Simulating an Inbound Call to the Interaction Center"

� Section 6.3.2, "Handling an Inbound Call in Oracle Interaction Center"

See Also
� Section 6.1, "Oracle Interaction Center Implementation Verification Tasks"

� Section 6.2, "Implementing the Web Phone for Inbound Call to the Switch 
Simulator"

6.3.1 Simulating an Inbound Call to the Interaction Center
Use this procedure to simulate an inbound call to Oracle Interaction Center.

 CCT:TOOL:IVR_DATA This profile option is for IVR data passed 
in the inbound call. It has the format 
k1=v11;v12;v13,k2=v21;v22

In this case v11, v12 and v13 would show 
is the drop-down list for k1 in the web 
phone interface. Please make sure the 
k1,k2 are exactly the same (case sensitive) 
as the "interaction_key" field in the "CCT_
INTERACTION_KEYS" table.

Note: The Web Phone page refreshes based on the value in the 
CCT:TOOL:REFRESH_RATE profile option.

Profile Option Value Example
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Login
HTML Login URL

Responsibility
CCT_WEBPHONE_DEMO_RESP

Prerequisites
� Use Internet Explorer.

� Configure your internet options for web phone use.

a. Choose Start > Settings > Control Panel.

b. Double-click Internet Options.

The Internet Properties window appears.

c. In the Temporary Internet Files area, click Delete Files.

d. In the Delete Files window, select Delete all offline content and then click 
OK.

e. In the Temporary Internet Files area, click Settings.

f. In the Settings window, under Check for newer versions of stored pages, 
select Every visit to the page and then click OK.

g. In the Interaction Properties window, click OK.

� If necessary, close all Internet Explorer sessions and restart Internet Explorer.

� Start the servers in the interaction center server group (see Section 5.6.5, 
"Starting Server Processes").

Steps
1. On the Web Phone tab, click Request Extension.

An extension appears starting with the extension defined in the EXTENSION_
RANGE_3_BEGIN parameters for the Switch Simulator. 

2. Click an extension number.

A web phone appears.

3. In the web phone, do one of the following:

� Click Speed Dial to dial the route point defined in the CCT:TOOL:DEFAULT_
ROUTE_POINT profile option for the user.
Verifying the Implementation 6-17



Testing Advanced Inbound Using the Switch Simulator
� Enter a route point and then click Dial.

The route point must be defined in the Switch Simulator parameters.

4. To make a call from another web phone extension, click Request Extension on 
the Web Phone tab and then click the new extension.

When a connection with the Switch Simulator is established, the state of the 
web phone is Connected and the Line button is green.

5. To hang up, click Release.

See Also
� Section 6.3.2, "Handling an Inbound Call in Oracle Interaction Center"

6.3.2 Handling an Inbound Call in Oracle Interaction Center
Use this procedure to handle an inbound call.

Login
Self Service Login URL

Responsibility
Customer Support or TeleSales Agent

Prerequisites
None

Steps
1. Navigate to the Universal Work Queue window.

The Universal Work Queue and Phone Extension window appear.

Responsibility Procedure

Customer Support � In the Navigator window, on the Functions tab, choose 
Universal Work Queue.

TeleSales Agent 1. In the Navigator window, on the Functions tab, choose 
eBusiness Center.

2. From the Tools menu, choose Universal Work Queue.
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If the following profile options are set to Yes, then the icWork Controller 
appears:

� IEU: Session History Logging. Enables the Break button in the icWork 
Controller.

� IEU: Queue: Work List. Enables the Next Work button in the icWork 
Controller.

� IEU: Message: UI: UWQ Notices. Enables the Notices tab in the icWork 
Controller.

� IEU: Queue: Inbound Telephony or IEU: Queue: Outbound Telephony. 
Enables the Phone tab in the icWork Controller.

The icWork Controller is a "floating’ window. You can move the icWork 
Controller window anywhere on your desktop -- even outside the Oracle 
Applications window.

For information about using the icWork Controller, review Oracle Universal Work 
Queue Concepts and Procedures.

2. In the Phone Extension window, enter the agent extension.

This is the extension associated with the agent in the interaction center 
parameters for the CRM resource (see Section 5.7.7, "Configuring Interaction 
Center Parameters for a CRM Resource").

3. To manually refresh work counts, from the Tools menu, choose Refresh.

The left pane of the Oracle Interaction Center window lists the available work 
nodes and the count, or number, of work items in each node.

4. In the Universal Work Queue window, expand the Media node and click 
Inbound Telephony.

Inbound calls counts are categorized by call classification in the detail pane. 

5. To start receiving inbound calls, click a call classification and then click Get 
Work.

The appropriate application window opens and displays the details of the work 
item. The Phone tab in icWork Controller displays the following information:

� ANI

� DNIS

� Call classification
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� Elapsed time

� Softphone state (for example, Call established)

� Media channel (for example, Inbound Telephony) 

6. To end the call and complete your work in the current interaction:

a. Click Release on the softphone to hang up the call.

b. Click Wrap Up in the application window.

c. Complete your work.

7. To end the interaction and request another call of the same classification:

a. Click End Interaction in the application window.

b. Select a call outcome.

You are now ready to receive inbound calls of the same classification.

8. To end the interaction and suspend call delivery:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

9. To request calls of a different classification:

a. Click Cancel Media Request in the Universal Work Queue window or 
Cancel in the icWork Controller.

b. Click End Interaction in the application window.

c. Select a call outcome.

Note: You do not have to click Next Call in the icWork Controller.

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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d. Click a different call classification and then click Get Work in the Universal 
Work Queue window.

See Also
� Section 6.3.1, "Simulating an Inbound Call to the Interaction Center"

Note: If a call is already on its way to you when you suspend call 
delivery, then you will receive one last call before your call delivery 
is suspended.
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Diagnostics and Troubleshooting

7.1 Common Implementation Errors
This document describes some installing, configuring, and troubleshooting 
Interaction Center Server processes.

7.1.1 NT Service : UNC network path
ICSM would not work as an NT Service if apps.zip is located via a mapped network 
drive. 

Steps
To correctly set up ICSM as an NT service :

10. Use UNC Style network path to point to the location of apps.zip ( IEO_JAVA_
TOP ) : \\host\path. e.g. \\cctre1-nt1\appl_top.

11. Modify the service to run with a NT User who have access to the network path. 
This can be done using NT Service Manager.

The reason behind this is that NT services are not associated with the login session, 
of which the network drive mapping are tightly coupled; thus mapped network 
drive are not accessible from NT service at all, which will result in ICSM not able to 
start (Some No Class Def Found Errors may be observed). 

7.1.2 NT service : Permission
ICSM NT service required to be run with System Administrator privileges. Assign 
the ICSM NT service with the correct user using the NT service manager.
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7.1.3  NT service : Changing ieoenv.cmd
If ieoenv.cmd is changed, the ICSM NT Service must be unregistered and registered 
again, otherwise the change in ieoenv.cmd will not be effective. The tool 
oamksvc.exe created by the FND team save a snapshot of the environment variables 
in the NT registry. When the service is registered, the environment variable values 
cannot be changed. Unregistering and Reregistering the ICSM NT service will take 
the latest values in ieoenv.cmd.

7.1.4 NT : Running in console mode
When ICSM is running in console mode ( by using ieoicsm.cmd console_start ), all 
server processes launched by ICSM will be killed when the ICSM process is killed 
(either by control-C or killed from Task Manager ). This would not happen if ICSM 
is shut down gracefully using the ICSM command line utility.

7.1.5 Default options
By default, ICSM will start all the server processes assigned to it when it is started 
and the log level is set to ERROR. To change these options, the ieoicsm.cmd / 
ieoicsm.sh must be edited. To turn off the start all option, remove -start_all from the 
Java command line in ieoicsm.cmd / ieoicsm.sh. To change the logging level, add 
-log_level {ERROR|WARNING|INFO|VERBOSE} to the  Java command line in 
ieoicsm.cmd / ieoicsm.sh.

Before and After applying patch ICSM must be shutdown before applying any 
patch affecting apps.zip and restarted when the patching is finished.

7.1.6 Java version : Running with JDK/JRE 1.1.8
If the Java version is 1.1.8, the line with "jdbc12.zip" must be commented out or 
removed from ieoenv.cmd or ieoenv.sh. Otherwise, the wrong JDBC driver will be 
used which is incompatible with Java 1.1.8.

7.1.7 UNIX : File descriptor limit
The default maximum number of file descriptors available to the shell and its child 
processes on most Unix systems is 64. Raise this number to 1024 in order to run all 
the java servers for a single site installation, or any subset of the java servers for a 
single site installation, on the same node. A higher number will be required if java 
servers for multiple single site installations will be run on the  same node. 
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Only a process with appropriate privileges (usually root) can increase the limit.  The 
command required to change the number varies with the flavor of Unix used. 
Please consult your Unix System Administrator.

An example for the Korn shell is shown below: 

1. Open a unix terminal in the machine where ICSM is going to be started. 

2. Change user to be root. 

3. Change shell to be korn shell ksh. 

4. Increase the file descriptor limit to 1024 /usr/bin/ulimit -n 1024. 

5. Start ICSM in this terminal To check the current file descriptor limit, type 
/usr/bin/ulimit -n.

7.1.8 HP-UX : Default Thread Configuration
The default number of thread allowed in HP-UX platform is 64. This has to be 
raised to at least 2048 to be able to support ICSM and all interaction center Java 
processes. Consult the HP-UX tuning documentation for more details. 

7.2 Log Files and Error Messages
Oracle Interaction Center server trace function outputs detailed information about 
server activity to a console window or a file. By default, the trace function is off.

To turn on the trace function, set the appropriate Oracle Interaction Center server 
database parameters. Optionally, when you start the Oracle Interaction Center 
server, use the appropriate command line parameters. The database parameter 
overrides the command line parameter.

The following command line options set the trace level for the Oracle Interaction 
Center server.

Trace Level Description

trace_level_error Server errors.

trace_level_warn Server warnings and errors.

trace_level_info Server events, warning, and errors.

trace_level_debug All server activity.
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The Oracle Interaction Center server does not support enabling or changing trace 
levels at runtime. You must stop and restart the server for changes take place.

See Also
� Section 7.1, "Common Implementation Errors"

7.3 Failure and Recovery

7.3.1 ICSM goes down

Failure
a. When ICSM is down you will not be able to start/stop individual servers. 

b. If ICSM is started as an NT service or via the ICSM shell script on Unix, all 
servers that are running will not be affected. All servers will continue 
operation as usual.

Recovery
a. Restart ICSM.

b. All servers will re-connect to ICSM within 5 minutes.

c. After 5 minutes you will be able to start and stop servers.

7.3.2 Database goes down.

Failure
a. When the database is down you will not be able to start/stop individual 

servers.

b. All servers will not be able to continue operation as usual but will go into 
an intermediate state waiting for the database to come up. 

Recovery
a. Restart the database.

b. ICSM will detect that the database has come up and reconnect to it.

c. Servers will detect that the database has come up and reconnect to it.
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d. You can continue operation as usual 5 minutes after the database has come 
up.
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Oracle Interaction Center Implementation

Worksheets

Topics include:

� Section A.1, "Oracle Interaction Center Administrator Worksheet"

� Section A.2, "Interaction Center Database Connectivity File Worksheet"

� Section A.3, "Interaction Center Server Manager Environment File Worksheet"

� Section A.4, "Employee Worksheet"

� Section A.5, "Employee User Account Worksheet"

� Section A.6, "CRM Resource Worksheet"

� Section A.7, "Single-Site Server Group Worksheet"

� Section A.8, "Multi-Site Interaction Center Worksheets for Advanced Inbound"

� Section A.9, "Middleware Configuration Worksheet"

� Section A.10, "Server Parameters Worksheet"

� Section A.11, "Teleset Worksheet"

A.1 Oracle Interaction Center Administrator Worksheet
User Name:

Password:

Responsibilities:

❏ System Administrator
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❏ CRM Resource Manager

❏ HRMS Manager, for example US HRMS Manager (if Oracle Human Resource 
Management System is installed)

❏ Call Center HTML Administrator

A.2 Interaction Center Database Connectivity File Worksheet

A.3 Interaction Center Server Manager Environment File Worksheet

A.4 Employee Worksheet
Last:

Gender:

Type: Employee

Parameter Value

TWO_TASK

FNDNAM

GWYUID

GUEST_USER_PWD

APPS_JDBC_DRIVER

DB_HOST

DB_PORT

Parameter Value

IEO_COMM_TOP

IEO_DBC_FILE

IEO_JRE

IEO_JAVA_TOP

IEO_IP

IEO_HOST
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Enployee (Number):

A.5 Employee User Account Worksheet
User Name:

Password:

Person (Employee):

Responsibilities:

❏ Preferences (to access personal profile options for Oracle Interaction Center)

❏ Customer Support (to access work in Oracle Universal Work Queue)

❏ TeleSales Agent (to access work in Oracle Universal Work Queue)

A.6 CRM Resource Worksheet
Name (Employee):

Resource Name (if different):

Transaction Number:

Resource Number:

See Also
� Section A.6.1, "CRM Resource Roles Worksheet"

� Section A.6.2, "CRM Resource Interaction Center Parameters Worksheet"

� Section A.6.3, "CRM Group Member Roles and Usage Worksheet"

A.6.1 CRM Resource Roles Worksheet
Resource Roles:

Role Type Role Start Date End Date

Telesales

Callcenter
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A.6.2 CRM Resource Interaction Center Parameters Worksheet
Interaction Center:

Middleware:

Agent Middleware Parameters:

A.6.3 CRM Group Member Roles and Usage Worksheet
Group Number:

Group Name:

Group Member Roles:

Group Usages: 

❏ Sales and Telesales

❏ Call Center

Parameter Value

ACD Data 1

ACD Data 2

Role Type Role Start Date End Date

Telesales

Callcenter

Role Type Role Start Date End Date
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A.7 Single-Site Server Group Worksheet
Server Group Name:

Location:

Description:

A.8 Multi-Site Interaction Center Worksheets for Advanced Inbound
Topics include:

� Section A.8.1, "Global Server Group Worksheet"

� Section A.8.2, "Local Server Group Worksheet"

A.8.1 Global Server Group Worksheet
Server Group Name:

Location:

Description:

A.8.2 Local Server Group Worksheet
Server Group Name:

Location:

Server Type Server Name Node Assignment

Interaction Queueing and Distribution

Inbound Telephony Server

Routing Server

Telephony Manager

Switch Simulator

Universal Work Queue

Server Type Server Name Node Assignment

Interaction Queueing and Distribution

Routing Server
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Middleware Configuration Worksheet
Description:

A.9 Middleware Configuration Worksheet
Server Group:

Middleware Configuration Name:

IP Address:

Port:

Middleware Type

❏ Connectors for CT-Connect

❏ Connectors for Cisco ICM

Server Type Server Name Node Assignment

Inbound Telephony Server

Telephony Manager

Switch Simulator

Universal Work Queue

Parameter Value

PBX Name

PBX Type

Route Point Set 1

Route Point Set 2

Route Point Set 3

Route Point Set 4

Route Point Set 5

CTI Enabler Server IP Address

Middleware Server Info 1

Middleware Server Info 2

Middleware Server Info 3
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Server Parameters Worksheet
A.10 Server Parameters Worksheet
Topics include:

� Section A.10.1, "Interaction Queueing and Distribution Parameters"

Middleware Server Info 4

Middleware Server Info 5

Middleware Server Info 6

Outgoing Prefix

International Dialing Prefix

Site Area Code

Site Country Code

Site Internal Number Length

Site Local Number Maximum Length

Site Overlay

IVR Host

IVR Port

IVR Info 1

IVR Info 2

IVR Info 3

IVRI Mode

IVRI Abandon Threshold

Domestic Dialing Prefix

Passive Mode

Use Advanced Outbound

Predictive Transfer Flag

Predictive Transfer Wait Time

Predictive Answer Flag

Predictive Answer Wait Time

Parameter Value
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Server Parameters Worksheet
� Section A.10.2, "Telephony Manager Parameters"

� Section A.10.3, "Inbound Telephony Server Parameters"

� Section A.10.4, "Routing Server Parameters"

� Section A.10.5, "Switch Simulator Parameters"

� Section A.10.6, "Universal Work Queue Parameters"

A.10.1 Interaction Queueing and Distribution Parameters
Server Name:

Node Assignment:

A.10.2 Telephony Manager Parameters
Server Name:

Node Assignment:

No parameters.

A.10.3 Inbound Telephony Server Parameters
Server Name:

Node Assignment:

Parameter Value

DATABASE_LOGGING

DEFAULT_TIMEOUT

IH_JDBC_CONNECTIONS

JDBC_CONNECTIONS

TRACE_LEVEL

Parameter Value

DATABASE_LOGGING

TELE_MIDDLEWARE_CONFIG

TRACE_LEVEL
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Server Parameters Worksheet
A.10.4 Routing Server Parameters
Server Name:

Node Assignment:

A.10.5 Switch Simulator Parameters
Server Name:

Node Assignment:

A.10.6 Universal Work Queue Parameters
Server Name:

Node Assignment:

WEB_CALL_PORT

Parameter Value

TRACE_LEVEL

Parameter Value

EXTENSION_RANGE_1_BEGIN

EXTENSION_RANGE_1_END

EXTENSION_RANGE_2_BEGIN

EXTENSION_RANGE_2_END

EXTENSION_RANGE_3_BEGIN

EXTENSION_RANGE_3_END

ROUTE_POINT_1

ROUTE_POINT_2

ROUTE_POINT_3

TELE_MIDDLEWARE_CONFIG

TRACE_LEVEL

Parameter Value
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Teleset Worksheet
A.11 Teleset Worksheet
Teleset Name:

Hardware Number:

Teleset Type

❏ Alcatel

Parameter Value

ENABLE_INTERACTION_BLENDING

ENABLE_LOGGING_AND_ALERTING

LNA_SPILLOVER_FILE

LOAD_CALC_RATE

MAX_ACTIVE_DB_CONNECTIONS

MAX_TIMEOUT_DURATION

MCM_TIMEOUT_DURATION

NETWORK_OBJECT_NUMBER

NETWORK_TRACE

NETWORK_TRACE_FILE

NETWORK_TRACE_LEVEL

NETWORK_USER_NUMBER

RECONN_WAIT_TIME

RUN_AO_IN_SIMULATION

SERVER_PORT

SESSION_CLOSE_DELAY

SESSION_TIMEOUT

TIMEOUT_WAIT_TIME

TRACE_FILE_NAME

TRACE_LEVEL

USE_AOLJ
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Teleset Worksheet
❏ Aspect

❏ Cisco

❏ Ericcson

❏ Lucent

❏ Nortel

❏ Rockwell

❏ Siemens

Server Group Name:

Middleware Name:
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Teleset Worksheet
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Oracle Interaction Center Server Param
B

Oracle Interaction Center Server

Parameters

The following table lists and defines the parameter names for which values can be 
set for Oracle Interaction Center servers. The following Oracle Interaction Center 
server parameters are loaded from the database. Database parameters override any 
command line parameters passed to the Oracle Interaction Center server. These 
parameters are strings when stored in the database.

Topics include:
� Section B.1, "Oracle Telephony Manager"

� Section B.2, "Oracle Interaction Queuing and Distribution"

� Section B.3, "Oracle Inbound Telephony Server"

� Section B.4, "Oracle Routing Server"

� Section B.5, "Oracle Switch Simulator" 

B.1 Oracle Telephony Manager 
JDBC_CONNECTIONS 
Specify number of JDBC connections used by Telephony Manager server. 

Default value = 3. Recommended range for this parameter is from 3-15. Higher 
value improves the real time performance of the OTM server process but uses more 
CPU and memory. 

IH_JDBC_CONNECTIONS 
Specify number of JDBC connections used by Telephony Manager for saving 
interaction history records to the database. 
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Oracle Interaction Queuing and Distribution
Default value = 1. Recommended range for this parameter is from 1-5. Higher value 
causes faster updates of interaction history data but uses more CPU and memory. 

TRACE_LEVEL 
Specify the type of messages logged to the trace file. 

Possible values are {fatal, error, warning, info, verbose}. 

Default trace level is error level messages only. 

DATABASE_LOGGING 
Possible values are {true, false}. 

Default is false. 

When database logging is turned on {true}, exceptions and error level messages are 
logged to the database and can be viewed in the Log Viewer page. Use database 
logging as a diagnostic tool only as logging will affect the performance of the 
system.

B.2 Oracle Interaction Queuing and Distribution 
DEFAULT_TIMEOUT 
This is the maximum amount of time in minutes the call waits in IQD. If the call is 
not picked up by an agent within the time specified in DEFAULT_TIMEOUT, the 
media item is sent to the Routing server to be re-routed. If a value less than 1 
minute is specified here, it will be ignored. 

Default value is INFINITE meaning that the call is not sent for re-routing and will 
wait till it is picked up by an agent. 

JDBC_CONNECTIONS 
Specify number of jdbc connections used by IQD. 

Default value = 3. Recommended range for this parameter is from 3-15. Higher 
value improves the real time performance of the IQD server process but uses more 
CPU. 

IH_JDBC_CONNECTIONS 
Specify number of jdbc connections used by IQD for saving interaction history 
records to the database. 

Default value = 1. Recommended range for this parameter is from 1-5. Higher value 
causes faster updates of interaction history data but uses more CPU. 
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Oracle Routing Server
TRACE_LEVEL 
Specify the type of messages logged to the trace file. 

Possible values are {fatal, error, warning, info, verbose}. 

Default trace level is error level messages only. 

DATABASE_LOGGING 
Possible values are {true, false}. 

Default is false. 

When database logging is turned on {true}, exceptions and error level messages are 
logged to the database and can be viewed in the Log Viewer page. Use database 
logging as a diagnostic tool only as logging will affect the performance of the 
system.

B.3 Oracle Inbound Telephony Server 
TELE_MIDDLEWARE_CONFIG
The name of the middleware configuration. 

TRACE_LEVEL 
Specify the type of messages logged to the trace file. 

Possible values are {fatal, error, warning, info, verbose}. 

Default trace level is error level messages only. 

DATABASE_LOGGING 
Possible values are {true, false}. 

Default is false. 

When database logging is turned on {true}, exceptions and error level messages are 
logged to the database and can be viewed in the Log Viewer page. Use database 
logging as a diagnostic tool only as logging will affect the performance of the 
system.

WEB_CALL_PORT
Obsolete 

B.4 Oracle Routing Server
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Oracle Switch Simulator
TRACE_LEVEL 
Specify the type of messages logged to the trace file. 

Possible values are {fatal, error, warning, info, verbose}. 

Default trace level is error level messages only. 

B.5 Oracle Switch Simulator 
The switch simulator simulates a Nortel Meridian switch.

EXTENSION_RANGE_1_BEGIN 
Specify beginning of your virtual extension range for line 1 of each teleset. 

EXTENSION_RANGE_1_END 
Specify end of your virtual extension range for line 1 of each teleset. 

EXTENSION_RANGE_2_BEGIN 
Specify beginning of your virtual extension range for line 2 of each teleset. 

EXTENSION_RANGE_2_END 
Specify end of your virtual extension range for line 2 of each teleset. 

EXTENSION_RANGE_3_BEGIN 
Specify beginning of your virtual extension range for the web phone. 

EXTENSION_RANGE_3_END 
Specify end of your virtual extension range for the web phone. 

ROUTE_POINT_1 
Specify a route point number. 

ROUTE_POINT_2 
Specify a route point number. 

ROUTE_POINT_3 
Specify a route point number. 

TELE_MIDDLEWARE_CONFIG 
Specify the name of the middleware configuration 

TRACE_LEVEL 
Specify the type of messages logged to the trace file. 
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Oracle Switch Simulator
Possible values are {fatal, error, warning, info, verbose}. 

Default trace level is error level messages only. 
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Oracle Switch Simulator
B-6 Oracle Applications Interaction Center Implementation Guide



Oracle Interaction Center Command Line Param
C

Oracle Interaction Center Command Line

Parameters

The following table lists and defines the parameters that can be set using the Oracle 
Interaction Center server command line:

ieoicsm cmd 

C.1 Starting Interaction Center Servers

C.1.1 ieoicsm start
Start Interaction Center Server Manager.

C.1.2 ieoicsm start -start_all {true|false}
Start all server processes assigned to the node.

true - Starts all server processes when Interaction Center Server Manager is started.

false - Does not start all server processes when Interaction Center Server Manager is 
started.

Default: true

C.1.3 ieoicsm start -start_default_config {true|false}
Start the default server group configuration, if it exists. 

true - Starts the default configuration when Interaction Center Server Manager is 
started.
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Stopping Interaction Center Servers
false - Does not start the default configuration when Interaction Center Server 
Manager is started.

Default: false

C.1.4 ieoicsm console_start
(Windows NT only) Start Interaction Center Server Manager in console mode.

C.1.5 ieoicsm console_start -start_all {true|false}
(Windows NT only) Start all server processes assigned to the node.

true - Starts all server processes when Interaction Center Server Manager is started.

false - Does not start all server processes when Interaction Center Server Manager is 
started.

Default: true

C.1.6 ieoicsm console_start -start_default_config {true|false}
(Windows NT only) Start the default server group configuration, if it exists. 

true - Starts the default configuration when Interaction Center Server Manager is 
started.

false - Does not start the default configuration when Interaction Center Server 
Manager is started.

Default: false

C.2 Stopping Interaction Center Servers

C.2.1 ieoicsm stop
Stop Interaction Center Server Manager.

C.2.2 ieoicsm stop -kill ip_address 
Stop Interaction Center Server Manager at the specified IP address.
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Interaction Center Server Manager Command Line Utility
C.2.3 ieoicsm stop -stop_all {true|false}
Stop all server processes on the node and Interaction Center Server Manager.

true - Stop all server processes when Interaction Center Server Manager is stopped.

false - Does not stop all server processes when Interaction Center Server Manager is 
stopped.

Default: false 

C.3 Interaction Center Server Manager Command Line Utility
Use the Interaction Center Server Manager command line utility to start, stop, and 
monitor Interaction center server from the command line.To start the Interaction 
Center Server Manager command line utility, run:

ieoicsm cmd

Once started, you can invoke the following commands.

C.3.1 start <serverName>
Description: Start a server. 

Parameters: serverName - name of the server

C.3.2 stop <serverName>
Description: Stop a server.

Parameters: serverName - name of the server

C.3.3 status <serverName> 
Description: Report whether a server is up or down.

Parameters: serverName - name of the server 

C.3.4 assign <serverName> <ipAddress> 
Description: Assign a server to a node. 

Parameters: 

serverName - name of the server 
Oracle Interaction Center Command Line Parameters C-3



Interaction Center Server Manager Command Line Utility
ipAddress - the IP address of the machine that the server is to be run 

C.3.5 quit 
Description: Quit the command line utility 
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